
Action Menu
Choose Action from the Menu Options. The Action Menu provides a means of 
interacting with the game. It allows access to the features that create an action within 
the game. If the Action Menu item is grayed, then it is not available in the current game 
state. The Button Bar contains some of the current Action Menu items and can be used 
in addition to the Action Menu. The Action Menu contains the following items:

Continue (Hot Key = Enter) - Select this item to go to your next shot. Follow all of 

the same procedures as you did for the first shot keeping in mind distance and position 
changes.

Mulligan (Hot Key = M) - This item will be available if you allowed mulligans in the 

Game Settings screen and have mulligans remaining. Select it to re-hit the last shot.
Gimmie (Hot Key = G) - This item will be available if you allowed gimmies in the 

Game Settings screen and you are within the selected distance of the cup. Select it to 
hole out and move to the next tee.

Replay Shot - Select this option to admire a wonderful shot or to remind yourself 

of what to avoid in the future. A sub menu will appear with replay options. Select the 
option to view a replay.

Move Camera (Hot Key = Space Bar) - Moves the view of the Swing Camera so 

that the perspective changes. This is useful once you have repositioned the golfer with 
the aimer arrow so you can see where your shot will be heading. This becomes 
available once you have repositioned or rotated the golfer.

Rotate To Flag (Hot Key = Shift + R) - Rotates the golfer to face the flag of the 

current hole.
Drop Ball (Hot Key = D) - Choose a different location for the ball. Choosing this 

option will cost you a stroke.
Find Flag (Hot Key = F) - If you cannot see the pin from your lie, select this option 

to display an extension of the pin (flag stick).
Display Grid (Hot Key = X) - This will lay down a geometrical grid over the 

immediate landscape in front of the golfer. A grid is useful for showing terrain changes 
and the break (slope) of a green. Select it a second time to remove the grid.

Pick Up (Hot Key = U) - Pick up the ball and move to the next hole. This option 

can be selected from the Game Settings screen and becomes available during games 
to allow a player to concede the hole.

Pull Pin (Hot Key = P) - Takes the pin out of the hole. Select it a second time to 

put it back.
Select Club (Hot Key = I or W or + #) - Brings up the golf bag and allows you to 

select a club from it.
Chip With Club (Hot Key = C) - Alters the golfer’s stance to one of a chipping 



stance using the current club. Selecting this option again will change the club back. You 
will only be allowed to chip with irons.

Blast With Club (Hot Key = B) - Used for getting the ball out of the sand. The ball 

will behave similar to the flop shot but not travel as low. Selecting this option again will 
change the club back. You will only be allowed to blast with irons.

Shot Setup (Hot Key = S) - Allows you to customize the players stance, club face, 

and ball position.
Show Ball Tracer (Hot Key = T) - Activates a tracer trail of the ball flight to make it 

easier to view the flight path.



Analyze The Shot
Before each swing, analyze exactly how to get to your ideal position. The ability to 
analyzing a shot correctly can greatly improve your score. PGAC Golf gives you all the 
tools necessary to correctly analyze your next shot and make the necessary 
adjustments to put the ball where you want it. A typical shot analysis will involve the 
following:

Distance - The distance indicator shows whether the current player's path to the 

hole is uphill or downhill, the distance the ball is above or below the hole, and the 
distance between the ball and the pin. Check any point on the course by right clicking 
on the position you wish to check. A distance indicator will show you the distance and 
elevation to that point. Examine the current club, and determine if the shot will require a 
full or partial swing. The elevation will change the club distance. If the pin is higher, the 
ball will not travel as far, if the pin is lower, the ball will travel further.

Lie - The lie indicator will show the type of terrain the ball is currently in. Some 

terrain may dramatically affect the ball flight while others will not affect it at all. Some 
clubs are harder to hit than others on various terrain. It may seem impossible to hit the 
ball out of sand with a wood, but irons will do the job quite nicely. Also check the area in 
front of the shot. If it is heavily wooded, it may be a good idea to change directions just 
to get out of the trees. If there are undesirable areas, you may want to try to carry them 
or lay up. Some terrain types are more prone to miss hits Shanks, heels, and toes can 
be common on some terrain if the club is not centered on the ball.

Slope of Lie - The slope of the lie is an important indicator of how the club will 

strike the ball. If you have trouble seeing the slope of the terrain, use the Grid option. 
You can compensate for these affects using Shot Setup.

Uphill Lie - The shot path direction is going up hill. Since the golfers feet are at 

different elevations, the club face is angled up which will produce more loft. 
Downhill Lie - The shot path direction is going down hill. The club face is angled 

down which will produce less loft.
Above Side Hill Lie - The ball is above the golfers feet. When the golfer 

compensates for the elevation difference by lifting the club, the ball will tend to draw 
(curve left.)

Below Side Hill Lie - The ball is below the golfers feet. When the golfer 

compensates for the elevation difference by lowering the club, the ball will tend to fade 
(curve right.)

Wind - The wind indicator shows the velocity of the wind. It displays the speed 

and direction relative to the view. The wind speed will vary according to what you 
selected for Wind Conditions in the Game Settings screen. Depending on the wind 
direction and speed you may need to select a different club or aim differently. The 
affects of the wind on the ball can be compensated for in most cases.

Club Selection - The club selection is one of the most important parts of the shot. 



Evaluate the wind direction and speed, the lie, and distance to the pin. The caddie will 
usually do a pretty good job at this but a seasoned golfer should always make the final 
decision.

Aiming - Try to read the green using the Grid and possibly a different camera 

view. Adjust for the break in a green by aiming the golfer. Check the wind direction and 
speed, you may need to aim into the wind in some cases in order to counter the drift it 
will have on the ball. Aim the golfer using the left and right arrow keys, or use the aiming 
slider button at the bottom of the Swing Camera. Once the golfer direction has been 
changed, the perspective can then be rotated to the new direction using Rotate View 
(R) in the Action Menu or from the Button Bar.

Shot Setup - Increase or decrease a club's loft by changing the golfer's stance. 

You can adjust the club face to open or closed, and the swing plane to outside-in or 
inside-out. Shot Setup will then allow you to save your custom shot types. This is an 
advanced feature that will allow you ultimate control over the golfer's swing.

It is strongly recommended that you take your golfer to the practice areas. This way you 
can learn the characteristics of each shot analysis item. You can test different theories 
and adjust short comings. For the serious golfer who is concerned about scores, 
learning these techniques will provide a huge advantage over those who do not.



Button Bar (Architect)
The Button Bar is available on the application just below the Menu Options. The button 
bar buttons are quick references to the Menu Options. The most commonly used 
features of the course architect are quickly accessible from the application Button Bar. 
For a quick description of any of the buttons available, move the cursor over the button 
in question for a second or two and a message will appear that describes the button’s 
function. Use the View Menu to show or hide the button bars.

File and Edit Buttons - The File Buttons are used to create, open, and save the 
course and are also available in the File Menu. The Edit Buttons are used to delete, 
duplicate, and undo selections and are also available in the Edit Menu.

Tools Buttons - The Tool Buttons contain options to create or edit shapes and 
objects in the Work Window. You can measure or rotate existing objects and make 
elevation changes to the course. These options are also available in the Tools Menu. 
The Land Tools are powerful operations that allow you to create hills, bunkers, and 
slopes. The Click-Click, Forest, and Hole Definition tools allow objects to be placed 
on the course and tees, pins, and shot paths to be selected for a hole.

Window Buttons - Lets you select an alternate way to view the course and its 
elements. These options are available in the Windows Menu and the  Librarian can 
be accessed from the View Menu.

Work Window Buttons - These options allow you to move the Work Window 
around the course and zoom in and out of selection. These buttons are available in 
the View Menu.

Note: Each of the four groups of buttons can be dragged off the main button bar. 

Each group then becomes its own button bar. These button bars can be rearranged, 
docked to either side or the bottom of the application window, or can be left floating in a 
button bar window by themselves.



Button Bar (Game)
The Button Bar is available within the Swing Camera. You can access it by clicking on 
the Options button in the lower left corner of the screen. You can keep the Button Bar 
visible by de-selecting Hide Button Bar from the Window Menu. This will cause the 
Button Bar to cover up part of the Swing Camera. The Button Bar options are also 
available in the Action Menu.

The Button Bar presents options available during game play, both before and after the 
shot. For a quick description of any of the buttons available, move the cursor over the 
button in question for a second or two and a message will appear that describes the 
button’s function.

Before the shot, the Button Bar includes buttons such as, Drop Ball, Find Flag, Show 
Grid, and Move Camera.

Drop Ball (Hot Key = D) - Drop the ball in a new location.

Find Flag (Hot Key = F) - Show the flag.

Show Grid (Hot Key = X) - Shows a geometrical grid over landscape in front of 

the golfer. Selecting it again will hide the grid.
Move Camera (Hot Key = Space Bar) - Moves and rotates the view of the Swing 

Camera to match the golfer's position.
Pick Up (Hot Key = U) - Pick up the ball and move to the next hole. This option 

becomes available during games where the type of play allows a player to concede the 
hole.

Gimmie (Hot Key = G) - This button will appear if you allowed gimmies in the 

Game Settings screen AND you are within the selected distance of the cup.

Several changes occur to the Swing Camera and Button Bar after a shot is made. The 
shot yardage is indicated in the upper left region of the window and the Button Bar 
changes to include Continue, Replay, Mulligan, and Gimmie.

Continue (Hot Key = Enter) - Click this button to go to your next shot.

Replay - Click this button to replay the last shot. Select from many different 



camera directions.
Go To Ball (Hot Key = Shift + Enter) - Move the golfer up to the ball without 

rendering. This is useful for speeding up game play.
Mulligan (Hot Key = M) - This button will appear if you allowed mulligans in the 

Game Settings screen.
Gimmie (Hot Key = G) - This button will appear if you allowed gimmies in the 

Game Settings screen AND you are within the selected distance of the cup.

For a more detailed explanation of each item, see the Action Menu.



Camera Editor
The Camera Editor screen can be accessed by clicking on the  camera button in the 
top right corner of any open camera, or by creating a new camera by selecting Custom 
Camera in the View Menu.

The editor will come up with the current window settings if editing, and the default 
settings if creating a window. To customize the window, change any of these settings:

Move and Rotate - Customize the camera position and direction with the 

 camera icon. Click in the square box and drag it around to change the camera 

position, or click on the lens to change it's direction. Click the Apply button to view the 
changes.

Elevation - Increase or decrease the camera elevation by dragging the slider 

button.
Pitch - Increase or decrease the pitch of the camera by dragging the slider 

button.
Attach Camera To - Select the player this camera should follow. If ReadyPlay™ 

is selected on Options in the Game Settings screen, then you will be able to swing your 
player and will not need to watch the others take their swing. This combo box will 
contain the players that are allowed to be attached to:

Swing Camera - You will only be allowed to follow the local human players or the 

furthest away in the group if there are more than one. If there are no local human 
players, then you will be allowed to follow any player.

Alternate Cameras - You will be allowed to follow any player on the course, or 

the furthest away in a group.



Camera Position - Select a default camera position and direction relative to the 

pin or the hole. If the camera position is relative to the player, the scene to the left will 
show a ball in the lower area and the camera position will be shown by a small 

 camera icon. If the camera position is relative to a hole, the scene to the left will 

show a top view of a typical hole.
Maximum Performance - Select this option to increase the frame rate 

performance of the camera. All cameras that have this selected will share the average 
maximum performance. Cameras that do not have this option selected will use the 
remaining performance.

Default Settings - Use the default settings for the current Camera Position.

Apply to render the camera being edited and view the changes.

Cancel to return to the game.

OK to apply the changes and return to the game.



Camera Window
The Camera Window is used to see the course as a golfer would. It is also useful when 
verifying elevation changes made using the Tools Menu. Object and land shapes cannot 
be added to this view directly but must be added to the Work Window. The result would 
then be visible in the Camera Window.

A camera icon  is associated with the Camera Window which can be moved around 
the course and rotated to different directions. The camera can also be made to point up 
and down within certain limits.

Open Window - Select Camera Window from the Window Menu, or Button Bar.

Close Window - Clicking the camera icon with the right mouse button and select 

Close Camera View from the menu that appears, or click on the standard windows icon 
in the upper right corner.

Position Window - While the view is open, the camera position is represented in 

the Work Window by a 
 small icon. To move the camera, hold the left mouse button down in the center of the 

camera icon and drag the camera to a new location. To aim the camera, hold the left 
mouse button down in the triangle lens of the camera icon and drag the cursor to the 
new direction. The Camera Window will redraw after each change. If you want to make 
multiple movements in the camera (such as a move, followed by a rotate) without 
redrawing after each action, hold the Control key down, make your position changes, 
and then let up on the key to redraw the camera.

Properties - Change the elevation and pitch of the camera using the properties 

dialog. To open the dialog box, right click on the camera icon and select Properties... 
from the menu that appears. Use the sliders on the dialog to change the elevation, 
pitch, and direction of the camera.

Center the camera - Hold down the Ctrl key and press C to center the camera on 

the Work Window or use the View Menu.

Note: When the camera is very high, small changes in elevation will be difficult to 

see in the Camera Window. Position the camera close to the ground to see small 



changes in elevation. Position the camera about nine feet off the ground to view the 
course as the golfer would see it when the course is played.



Changing The Club
If you have Caddie Suggestions selected on the Player Settings screen, the most 
appropriate club will automatically be placed in the golfer’s hands before each shot. This 
club is displayed in the lower left corner of the Swing Camera.

If you want to override the suggested club or if you do not have Caddie Suggestions 
selected, click the club icon in the lower left corner of the Swing Camera to change it 
(you will probably need to do this before every shot without a caddie suggestion). This 
will display your golf bag. The golf bag will contain the clubs that were selected when 
the player was last edited. The average distance the club can reach is determined by 
the player ability setting. Choose the desired club from the bag by clicking on it. The golf 
bag will disappear and the new club will appear in the lower left hand corner. Exit the 
club selection mode by pressing ESC or clicking outside the bag.

To select a club using hot keys, just type W or I + (club number). Woods are selected 
by typing W + # and irons are selected by typing I + #. If the player does not have the 
selected club, then the club with the closest characteristics is chosen.

Note: Wood hot keys are

D1 = W + 0 3W = W + 3 6W = W + 6
D2 = W + 1 4W = W + 4 7W = W + 7
2W = W + 2 5W = W + 5

Iron hot keys are
1 I = I + 1 6I = I + 6 PW = I + P
2I = I + 2 7I = I + 7 SW = I + S
3I = I + 3 8I = I + 8 LW = I + L
4I = I + 4 9I = I + 9 Putter = I + 0
5I = I + 5

For more information about which club to choose, see the section on Choosing A Club. 
This lists the loft and advanced distance of every club.



Choose A Game
You can play alone on your home PC, with co-workers over a LAN (local area network), 
join up with friends across the country via modem, or using the World Opponent 
Network (WON) and establish golfing buddies around the world. If you have the desire 
to play golf, PGAC Golf provides you the opportunity to get connected.

Hosting and joining a remote game are similar for all connection methods.

Click on the connection type you wish to make
Local Game (single computer) - One or more users playing from the same 

computer. Each user can control one or more players/golfers, or play against groups of 
computer players. This option will bring up the Game Settings screen to actually start 
the game.

Remote (LAN/Modem) - Remotely connect with co-workers across a LAN (local 

area network), or with friends using a direct modem connection. This option will bring up 
the Choose Connection screen which contains the connection methods available on 
your machine via Microsoft’s Direct Play™, a family of connection technologies which 
allows you to play over various connection types (Direct Play is part of DirectX, which is 
provided if your system doesn’t already have it installed). If your system has the 
necessary components for the Direct Play option, it will be displayed. For example, if 
your system doesn’t have a modem installed, the Modem Connection option will not be 
displayed.

Internet (  World Opponent Network (WON)  )   - This option allows you to play 

with people all over the world via this FREE Internet gaming system. This option will 
bring up the WON interface for logging into the server, meeting up with people, and 
starting games or tournaments.

Back to the Main Menu screen.
Cancel to the Main Menu screen.

Next to the Remote Game or Game Settings screen.



Choosing A Club
There are 21 clubs available to each player; however, only 14 of those clubs can be 
used at any one time, 13 clubs plus a putter. The Clubs In Bag option on the Player 
Settings screen, allows you to select the clubs the player will carry onto the course. 
Each club has specific properties associated with it that should be taken into account 
when selecting the clubs:

Angle - This is the angle of the club face and it is what gives the ball loft. The 

lower the angle, the lower the ball flight.
Distance - The distance of the club is an average distance for players with 

standard ability.

The angle and distance specifications for an advanced player’s clubs are listed 
below.

Club Angle Distance
D1 9.5° 275 yds
D2 12° 270 yds
2W 14° 260 yds
3W 16° 250 yds
4W 18° 235 yds
5W 21° 215 yds
6W 23° 200 yds
7W 25° 190 yds
1I 18° 235 yds
2I 21° 220 yds
3I 24° 205 yds
4I 27° 195 yds
5I 31° 185 yds
6I 35° 172 yds
7I 39° 160 yds
8I 43° 148 yds
9I 47° 135 yds
PW 51° 120 yds
SW 56° 90 yds
LW 60° 70 yds

The putter is always present in the golf bag and is usually used exclusively on the green 
or around the fringes of the green. Check the other clubs you wish to have in the 
player's bag. If you accidentally select too many, you’ll receive a friendly error message. 
This is a lot better than the disqualification you would experience in an actual 
tournament for this rule infraction.

Caddie Suggestions - The caddie calculates distance to the pin, elevation difference, 
and course conditions. The caddie will then suggest a club using the player's statistics 
for average club distance. If the caddie does not select the club you desire, it can be 



changed easily during game play. Whenever Regulation rules are selected from the 
Game Settings screen, and the player is using caddie suggestions, then statistics will be 
kept on the average distances hit with each club. Over time, the caddie will learn how 
the player uses each club and give better suggestions.

Note: To see the player's club statistics during game play, turn on screen tips, 

then place the cursor over a club in the bag for a few seconds. A screen tip box will 
appear with the current yardage.

No Caddie Suggestions - The driver will come up at the beginning of the hole, the 
default chipper when just off the green, and the putter will come up whenever the player 
is on the green. If a different club is desired, you will need to select a new club before 
each shot.



Computer Player
A computer player can be created by selecting the Computer Player button in the 
Ability Level section of the Player Settings screen. After editing the golfer using the 
Player Editor screen, click Next to get to the Computer Player customization screen.

To customize the computer player’s ability, adjust these statistics as desired. For default 
values of Basic, Standard, and Advanced ability, use the Ability Level check buttons in 
the Player Settings screen. The computer player will then play to these new statistics.

Driving Distance - The average distance that a computer player can hit the ball. 

This value can be set anywhere from 200 to 310 yards.
Driving Accuracy - Set the accuracy of this player's drives by entering the percent 

of drives that reach the fairway. This value can be set anywhere from 40% to 90%.
Average Putts - Set the average number of putts per hole this player will take in 

order to get the ball into the cup. This values can be set anywhere from 1.6 to 4.5 putts.
Sand Saves - Set the percentage of time the player will be able to save par after 

landing in the sand. This value can be set anywhere from 10% to 75%.
Scrambling - Set the percentage of time the player will be able to save par 

without getting a green in regulation. This value can be set anywhere form 10% to 75%.
Regulation Greens - Set the percentage of time the player will make a green in 

regulation (strokes are par - 2 when ball is on the green.) This value can be set 
anywhere from 10% to 85%

Birdies - Set the average number of birdies this golfer will make per round. This 

value can be set anywhere from 0 to 5.5.
Scoring - Set the average number of strokes per round. This value can be set 

anywhere from 66 to 144.
Computer Learning - Allow the computer player to learn after every swing. The 

more the computer players play, the better they get.
Random - Creates a random ability for the computer player. Each consecutive 

click of the Random button presents different settings.



Back to the Player Editor screen.

Cancel to the Who's Playing screen.

Finish to create the player and return to the Who's Playing screen.



Welcome to PGA Championship Golf 1999 Edition

This help system has been written in order to guide you through the essentials of 
playing PGAC Golf and using the Course Architect.

Introduction - Welcome to PGA Championship Golf.

Getting Started - Starting PGA Championship Golf.

Playing a Game - Starting and playing a game of golf.

Using the Course Architect - Create and edit custom courses.

Installing and Managing Courses - Install, move, and delete course files.

Trouble Shooting - Fix problems and get technical support.

Credits - About the developers.

We hope that you find PGA Championship Golf both challenging and rewarding. 

Don't expect to hit 10 under par your first round, but as you develop the skills on some 
of the world's best golf courses, you'll soon develop a feel for the game. We hope you 
enjoy many great rounds!



Using the Course Architect
The Course Architect allows YOU to create custom courses that can be played using 
PGA Championship Golf. Courses built with the architect can be shared with others and 
played in remote games.

The tools to create a new course are as follows:
Menu and     Button Options- Use these options to make selections and customize 

the course.
Create a   New Course   - Quickly lay out any number of holes (up to 18) and 

outline the terrain shapes, then apply terrain to shapes that make up each hole (rough, 
fairway, water, etc.)

Use the View Interface - Use the visual interface to navigate and create custom 

courses.
Improve Performance - Remove redundant and     unnecessary data   from the 

course and reduce the course perimeter.

Course Architect   (Philosophy)   - Great artists can create spectacular works 

regardless of the tools given them to work with, but with the right tools, anyone can 
create something they can feel proud of. A course is much more then just the sum of it's 
holes, the way holes interact with each other and with the terrain can play an important 
role. Our response was to create the Course Architect with the tools necessary to allow 
anyone to create a prize winning course with minimal effort and to allow the creation of 
an entire course (not just individual holes.) Whether you are one of the great architects 
or just a computer game fanatic trying to get the most out of a game, we believe you will 
find the Course Architect fun and easy to use.



Course Conditions
Select the course conditions from the Game Settings screen. The default course and 
weather conditions provide a normal day on the course. Changing these conditions 
allows you to change the difficulty of the game. You can view the conditions during the 
game by looking in the upper left corner of the Scores screen or right clicking on the sky 
from any view. There are three course conditions that are customizable:

Rough Length - Adjust the length of the rough grass. Changing the length of the rough 
will affect a swing out of the rough and the ball speed as it comes in contact with the 
rough.

Short (Freshly cut) - It is easy to hit the ball out of short rough. The ball tends to 

travel longer distances because the club and ball are not slowed by impact with the 
rough. It is easy to make good contact with the ball.

Average (An average course on an average day) - The ball tends to travel shorter 

distances than what would be expected because the club and ball are slowed by impact 
with the rough. Miss hits can be caused by the grass interfering with a clubs alignment 
with the ball.

Long (Moments before the mowers are started) - It is difficult to hit the ball out of 

long rough. The ball tends to travel shorter distances because the club and ball are 
drastically slowed by impact with the longer grass. Using one club longer (“clubbing up”) 
would be a good idea in long rough. Miss hits are frequent because the long grass 
exaggerates a misaligned club face.

Green Conditions - Adjust the moisture on the green. Moisture has the greatest effect 
on the green.

Wet (Shortly after a rain shower) - When the ball is hit onto the green, it will lose 

most of its momentum on impact. The green tends to act as a wet sponge and will 
cushion the ball as it lands. Putts tend to be short because of increased friction.

Moist (Early morning dew) - The ball will loose some momentum on impact with 

the green. The green will cushion some of the momentum as it gives a little. Putts tend 
to be slightly shorter because of increased friction.

Normal (Average green on an average day) - The ball will be slowed somewhat 

by the grass. Learning to putt on normal green conditions will help your ability to adjust 
for other green conditions.

Dry (A summer afternoon) - It is more difficult to keep approach shots on a dry 

green because of the tendency for a ball with momentum to bounce when it hits. Putts 
tend to roll longer than usual because of reduced friction.

Very Dry (Summer in the desert) - The ball will ricochet off the green at first 

impact. The ground is hard and does not give at all. You’ll need to roll approach shots 
onto the green. It will seem impossible, at times, to hit a short putt because of 
decreased friction.



Wind Conditions - Adjust the strength of the wind. The wind will affect the ball while in 
the air. A gusty wind can be unpredictable, which makes it hard to play in higher winds.

Still (Zero wind) - This option is good for testing swings. Turning off the wind can 

help you concentrate on the swing, not the weather. This is a rare condition in the real 
world.

Calm (Ideal golfing conditions) - There is generally some amount of wind during 

calm conditions, anywhere from zero to five miles per hour for a calm day. The wind 
rarely changes direction or gusts. The wind can carry the ball a little and hopefully result 
in better placement. This is considered a normal condition.

Breezy (Summer breeze) - Anywhere from five to ten miles per hour. The wind 

rarely changes directions or gusts. A tail wind can carry the ball a few yards on long 
drives. This is considered a normal condition.

Gusty (Don’t forget your kite) - Quite a bit of wind for playing golf. Anywhere from 

ten to twenty-five miles per hour. The wind changes direction frequently and will gust at 
times. A tail wind can carry the ball great distances during strong gusts. This is 
considered an unusual condition.

Strong (Batten down the hatches) - Bring plenty of balls and some goggles. 

Anywhere from twenty-five to forty miles per hour. The wind changes direction 
frequently and will gust at times. The wind will completely destroy that perfect shot and 
ruin your new do. This is considered to be good weather to stay inside and play PGA 
Championship Golf.

Note: You may set the course conditions to change randomly in the General 

Options. However, all conditions will be in place for the entire round or tournament.



Course Manager
The Course Manager handles the manipulation of courses being used for PGA 
Championship Golf. The Course Manager recognizes Course files (.crs), Course Library 
files (.clb), and Distribution files (.xcr.) 

Use the manager to do the following operations:
Installation - Double click on any one of the recognized files to launch the Course 

Manager and begin installation. You can also run it manually or select Course Manager 
from Course in the Game Settings screen. Then select Install Course/Library.

If the course or library is already installed, you will be prompted to replace the 

existing file.
Select the destination for the file(s) from the drive tree dialog.

If you are installing a course or library, the files will be copied to the destination. If 

you are installing a distribution file, all course and library files will be extracted and 
copied to the destination. In both cases, you can delete the original file after installation.

The course and library lists will then be updated with your new items.

Note: You will be informed during the installation process if you do not have the 

appropriate libraries. You need to have all libraries used in the course in order to finish 
the install.

Deletion - Highlight a course or library from the list boxes and select Uninstall 

Course/Library.
After prompting for approval to delete the selection, the manager will remove the 

corresponding files.
If you are deleting a course, you will have the opportunity to uninstall all libraries 



that are being used exclusively by the course.
You will be prompted to continue if you try to delete a library that is being used by 

another course.
The course and library lists will then be updated.

Moving - Highlight a course or library from the list boxes and select Move 

Course/Library.
Select the destination for the file(s) from the drive tree dialog.

If you are moving a course, then all files associated with the course will be 

moved to the new location. You will be prompted to move any library files that are being 
used exclusively by the course.

Setting Properties - Highlight a course or library from the list boxes and select 

Course/Library Properties.
The course properties will display a list of all libraries used by the course and the 

installed size of the course. There will be three edit boxes which display the location of 
additional course files. Each course can have a picture, a music bit, and an AVI in 
addition to the actual course and library files. You can delete the location by clearing the 
edit box, or select a new location for the file by moving it manually, then updating the 
text box. The file will not be copied or moved.

The library properties will display a list of all the courses that use it and the 

installed size of the library.
Packaging for Distribution - Package all the files associated with a course into 

one distribution file. You can then send this file others.
Highlight a course or library from the list boxes and select Compress Course 

Files.
Select the destination for the distribution file from the drive tree dialog.

You will be prompted to include custom libraries in the distribution file. Adding the 

libraries will make the file much larger. This is only necessary if you believe most people 
receiving the file do not already have them.

When the distribution file is complete, a notification message will appear. Now 

you can distribute the compressed file and it can be installed by others using the 
method described above.

Clear Course Statistics - Highlight a course from the list box and select Clear 

Course Statistics. You will be prompted to continue, then the statistics for that course 
will be deleted. This will reset the statistics for the course.

Download additional courses - Download additional courses and submit custom 

courses to the Sierra Golfing Association. Select Download Course/Library to open 
your web browser.



Course Options
All of the game options discussed in this section are available from the opening Main 
Menu screen by clicking Options or during the game by selecting Options (Ctrl + O) 
from the Game Menu. This opens a screen with four sections: General, Sound, Course, 
and Golfer. Click Course.

Tree and Object Detail - This setting will determine the detail of the objects to use 

on the course. Objects include such things as trees, ball washers, and tee markers. The 
default object size is based upon the machine speed and is set during the installation.

Panorama Detail - This option gives you the ability to choose between different 

details for the panorama (the horizon view of the course). The panorama settings offer 
None, Low, and High. Using the low detail panorama can reduce render time because 
memory usage is reduced.

Horizon Distance - This option lets you select the distance to render the course 

terrain. Select a distance anywhere from 350 to 750 yards. As the distance increases, 
the terrain that needs to be drawn increases. This will slow the redraw speed.

Shadow Distance - This option lets you select the distance to show shadows, or 

select None to turn them off. As the distance increases, the number of shadows that 
need to be drawn increases. This will slow the redraw speed.

Course Sizes - This option lets you change the size of permanent course data 

that will remain on the hard drive. Higher numbers result in quicker initial redraw times 
but take up more hard disk space.

Save Course Debris - The divots and discarded tees are not cleaned up every 

round when this option is selected.
Recommended Settings - Resets all options to the settings recommended for the 

current machine speed and ram requirements.



Course Perimeter
When a new course is created in the Course Architect, it is 2000 yds by 2000 yds. After 
creating the course, there is usually a lot of this area that is unneeded. The Create 
Course Perimeter option can be used to crop out all of the unneeded area in the 
course. By removing the unneeded area, the file size and memory usage will be smaller. 
This will shorten load times and increase performance when the course is played.

To crop out unused areas of the course, select the Create Course Perimeter from the 
Tools     Menu  . Draw the new course perimeter in the same manner as a land shape is 
drawn. Once the shape is completed, right click inside the shape and select Create 
New Course Perimeter from the menu that appears. You will be prompted to save the 
current course before the new perimeter is created.

Note: You cannot Undo this option after it has completed.

If the newly created perimeter removes any terrain that has 2D objects, 3D objects, or 
sounds on it, those objects are deleted as well. However, a new perimeter cannot be 
made that leaves dropped Land Shapes outside of the perimeter.

The course perimeter can also be made larger than the existing perimeter. This will add 
terrain to the course, and can be useful to create more area to work in.



Courses
First select a course to play from the list. The Course Tour button will display a short 
video that provides a look at the course, highlighting its special characteristics.

You can create your own courses using the Course Architect, or download courses that 
have been made by other players.

Note: Add-on courses are available through software retailers and the Course 

Architect. The name of the add-on course will appear in this list once it is installed by 
the Course Manager.

PGAC Golf ships with eight courses:

1. Royal Birkdale in northwest England - Since its founding in 1889 near Liverpool 
in northwest England, the Royal Birkdale Golf club has become one of golf's truly 
legendary courses. History-steeped, Royal Birkdale has hosted every major golf 
event in the United Kingdom: eight Open championships, including the most 
recent in 1998, two Ryder Cup Matches, the Walker Cup, the Curtis Cup, and 
numerous amateur tournaments. Repeatedly ranked one of the top two courses 
in the entire British Isles by Golf World, Royal Birkdale is also consistently rated 
among the top ten courses on earth by many of golf's greatest players.
Royal Birkdale's present course was created in 1931, and fine-tuned in 
succeeding years to incorporate advances in equipment, course design and 
talent. Currently, the links provide a "challenging, but fair" test. Each hole of the 
6,940 yard, par 70 course essentially runs in a valley between majestic sandhills. 
Staying on the fairway is demanding; but stray off it, and Royal Birkdale's rugged 
terrain, towering sandhills, buckthorn and scrub will quickly turn severely punitive.
Granted Royal patronage in 1951, the Royal Birkdale Golf club today proudly 
maintains its tradition of rigorous perfection. After 100 years, Royal Birkdale still 
delivers unsurpassed golf to players from around the world: a premier course in 
the land where golf was invented.

2. Sahalee in Northwest Washington - Rated one of America's 100 greatest golf 
courses by Golf Digest every year since 1979, the renowned Sahalee Country 
Club lies in the shadow of mighty Mt. Rainier on the Sammamish Plateau of 
Northwest Washington. Sahalee, meaning "High Heavenly Ground" in the 
Chinook language, combines the scenic wonders of the Great Northwest, with 
the athletic rigors of world class golf.
Extremely demanding, both mentally and physically, the club has hosted 
numerous tournaments over the years, including the 1998 PGA Championship. 
Offering snug fairways, artful trapping, and 6,955 yards of annual bluegrass and 
bentgrass perfection, Sahalee challenges even the best of golfers with rolling 
hills, seven lakes, and over seventy-five sand bunkers in a par 70 course.
Created by master designer Ted Robinson, past president of the Society of Golf 
Architects, the Club first opened in 1969. Today, Sahalee continues to provide its 



brand of superlative golf amidst the rugged beauty of the Pacific Northwest.

3. Pasatiempo in Santa Cruse, California - Nestled in the hills of Santa Cruse on 
the rugged California coast, Pasatiempo escapes from the rising crags and the 
crashing surf to reveal the majesty recognized as one of the great courses 
designed by Alester Mackenzie. Well Augusta may be Mackenzie's most famous 
course, Pasatiempo, Spanish for passing of time, was his most beloved, with the 
sixteenth hole his favorite in all of golf.
Opened in 1929, this 6,483 yard par 71 links style course, offers eighteen of golfs 
most challenging holes. True to the rugged terrain of the Monte Ray peninsula, 
Pasatiempo is not for the faint hearted. With it's numerous sand traps and 
complicated rolling greens, the berankas or deep ravines, cut across the back 
nine and force the choice between heroic shots or conservative routes, the true 
signature of McEnsy course. Neither the competitive golfer, nor the computer golf 
enthusiasts should miss the challenge of Pasatiempo.

4. Black Diamond Ranch in Lecanto, Florida - Set in the rolling countryside of 
Florida's Natural Coast, Black Diamond Ranch offers 27 holes of championship 
golf. Designer Tom Fazio's famed 18-hole "Quarry" course is ranked #1 in the 
state by Florida Golfer Magazine and one of the top 45 nationwide by Golf 
Magazine and 65th in the world! Opened in 1987, this 7,159 yard, par 72 course 
is carved out of a limestone quarry. A mix of extreme elevation changes, rolling 
tree-lined fairways, native sand dunes and exceptional design features 
compliment Black Diamond’s Signature holes, #13 through #17.    These five 
challenging holes run over and around the jagged and rocky cliffs of two retired 
quarries. Vertical drops of 100 feet, large boulders, wild flowers, cliffs, and the 
crystal clear Black Diamond Lake make these holes some of the most exciting to 
be found. A mere 15 minutes from the Gulf of Mexico, this lush private golf course 
is a must for any serious computer golfer.

5. Pete Dye Golf Club in Bridgeport, West Virginia - Located in a majestic, private 
valley, the legendary Pete Dye Golf Club combines the spectacular terrain of the 
West Virginia hills with the design genius of Pete Dye to create one of the most 
exciting and memorable courses any golfer could ever hope to play.
The Club - built on the site of a 19th century mine run by the world’s largest coal 
company - has preserved the remnants of that earlier era with museum-like 
quality, and integrated them into its design. Of course, there’s all the Pete Dye 
trademarks in the layout as well - such as deep, pot bunkers, wide fairways, and 
unobstructed green approaches.
Since 1993, the private Club’s 7,166 yard, par 72 course has presented a unique, 
uninterrupted experience between architect, game, and nature. The Pete Dye 
Club is a premier target course, sure to challenge even the most ambitious and 
proficient of golfers.

6. The Prince Course in Kauai, Hawaii - Welcome to Hawaii, and eighteen of the 
most magnificent holes of golf on earth... Located on the island of Kauai, the 



internationally renowned Prince Course straddles the striking bluffs that lead from 
the shores of the blue Pacific up to the island’s central headlands. Overlooking 
the scenic glories of Hanalei Bay .. at one with nature .. the Prince climbs uphill, 
leaps ravines, fords waterfalls, and then careens headlong back down towards 
the sea.
Integrated with the elements, challenging in the extreme, this 7,309 yard, par 72 
signature course was designed by Robert Trent Jones, Jr., and opened in 1990. 
Now ranked the Number One course in the entire State of Hawaii, The Prince - 
with its stunning views and superlative play - is truly the golf world’s reigning 
tropical paradise.

7. Coeur d’Alene Resort in northern Idaho - America's most beautiful resort golf 
course hugs the shore of Idaho's scenic Lake Coeur d'Alene in the rolling foothills 
of the Rocky Mountains.    And more than hugs - because the Coeur d'Alene 
course actually extends into the lake, to provide one of the truly unique 
challenges of the entire golf world:    the planet's only floating, moveable green.
As well as its famous man-made floating green, the 6,309 yard, par 71 Coeur 
d'Alene Resort Golf Course features bent grass fairways, an over-the-water 
driving range, and manicured greens.
Designed by Scott Miller - for years chief designer of courses "by Jack Nicklaus" - 
and opened in 1991, The Coeur d'Alene provides topnotch golf amid the splendor 
and tranquillity of the rugged, untouched West.

8. Jocassee Shoals in northwestern South Carolina - This fantasy course was 
designed by Jim Dickson and created with the PGA Championship Golf Course 
Architect.    We include it to give you an idea of some of the things that are 
possible with the architect.
Nestled above Lake Jocassee in the foothills of the Appalachian Mountains, 
Jocassee Shoals is a nature lover's paradise.    Rock and brush outcroppings 
serve as natural hazards, and the layout is routed with great care around two 
small mountain lakes.    The crowning jewel is majestic Lake Jocassee, which 
frames several holes as a scenic backdrop.    Despite its relatively short length 
from tee to green, Jocassee Shoals offers a variety of strategic and shot-making 
challenges in a beautiful setting.

Note: We have included three other sample Architect source files that can be 

loaded into the Architect. They are Mecklenburg Greens by Ken McHale, Abernathy Park by 
Steve Opfer, and Jocassee Shoals by Jim Dickson. These files are included to give you an 
idea of what can be done with the Architect. They can be found in the Sample Courses 
folder on the Installation CD.



Create Player
To create a player, click on the Create Player button on the Who’s Playing screen. You 
will then be taken to a series of player customization screens.

Player Settings - This screen allows you to customize the player's settings.

Player Editor - You can dress your golfer, choose a face, select hair, and choose 

other accessories.

Computer Player - You will only get this screen if you are using a computer 

player. Use these options to customize the computer player's ability.



Create Teams
Create the teams that will play in the next round of golf. This list can be used to move 
players and teams around, or automatically group them. A group of players will be on 
the same hole and see each other.

Auto Grouping - Select one of the auto grouping buttons.

Handicap - Sorts the group by handicap. Players with equal handicaps will be 

randomly grouped.
Score - Sorts the group by average round score. Players with equal average 

round scores will be randomly grouped.
Random - All players will be randomly grouped.

Manual Grouping - Group the players, teams, and groups in any order.

Players - Move the players by clicking on a players name in the list to highlight it. 

Use the up and down arrow keys to move the player in the list. All players will be shifted 
to make room for the player.

Teams - Move the teams by clicking on the team name in the list to highlight it. 

Use the up and down arrow keys to move the team in the list. The entire team will be 
moved to the new location. All teams will be shifted to make room for the team.

Groups - Move the groups by clicking on the group name in the list to highlight it. 

Use the up and down arrow keys to move the group in the list. The entire group will be 
moved to the new location. All groups will be shifted to make room for the group.

Group Size - Select the group size using the combo box. Group sizes must be a 

multiple of the current team size.



Cut Players After Round Two - This option will only be available if you selected 

72 holes from the Game Settings screen. After round two, half of the players will be cut 
from the tournament unless they scored within ten strokes of the leader. The teams will 
be reorganized by score. The players will not change teams.

Note: All human players that are playing from the same machine will be forced to 

play in the same group regardless of any grouping method used.
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Drop Ball
If the ball becomes unplayable, or if you find that a shot has ended up behind an 
obstruction (trees, bushes, etc.), you may need to drop the ball in order to clear your 
next shot. A drop results in a one-stroke penalty unless the ball lands on a cart path. If 
the ball lands out of bounds, you will be force to re-hit from the same location and it will 
cost two strokes.

Click the Drop (Hot Key = D) button. The cursor disappears and you are able to 

move the golfer around on valid drop areas. The allowable drop area extends two club 
lengths to either side of your existing lie, and no closer to the hole. You won’t be allowed 
to drop in hazards or out of bounds. When you are in an allowable drop area, left click 
and the golfer will drop the ball at that location. If the ball rolls out of bounds again, you 
will have to repeat the process.

You may find that you cannot drop the ball anywhere in the Swing Camera. If this is the 
case, you will need to use the new buttons that appeared in the Button Bar when you 
started the drop mode. To access the buttons, move your cursor to the lower left corner 
of the screen until it appears over the buttons. Then click on the button.

Nearest Relief - This button allows you to accept the suggested drop ball 

location. Use this button if you are having trouble with the ball always rolling out of play 
again.

Drop Backward - Reposition the view so you are directly behind your original 

position (remember, you can drop no closer to the hole). You may find that in order to 
have an allowable drop, you need to click the Drop Backward button at least once. You 
may click the Drop Backward button multiple times until you have a satisfactory area to 
drop. As you do this, you’ll notice that the allowable drop area increases in size.

Drop Forward - A new Drop Forward button appears after you click the Drop 

Backward button for the first time. This has the opposite effect of the Drop Backward 
button.

Done (Hot Key = ESC) - This option is only available when you are not being 

forced to drop. Select this if you decide not to drop the ball and want to return to the 
game.



Edit Menu
Choose Edit from the Menu Options to access the following commands:

Undo (Hot Key = Ctrl + Z) - Undo the last action (Insertion, Deletion or Terrain 

Manipulation) 
Delete (Hot Key = Del) - Delete all items that are currently selected in the Work 

Window.
Duplicate (Hot Key = Ctrl + D) - Make a copy of all items that are currently 

selected in the Work Window.
Select All - Selects all land shapes, paths, hazards, sounds, 2D, and/or 3D 

objects.
Drop Selected Shapes (Hot Key = Insert) - Drop all floating shapes that are 

currently selected in the Work Window. The shapes can still be dropped one at a time, 
by clicking the right mouse button on an existing shape and choosing Drop from the 
menu that appears, or by double-clicking in the shape itself.



File Menu
Choose File from the Menu Options to access the following commands:

          New (Hot Key = Ctrl + N)   - Creates a new empty course, 2000 by 2000 yards.

        New Course Wizard...   - Starts the new course wizard which leads you through 

the creation of a course.
          Open (Hot Key = Ctrl + O)   - Opens an existing course that was previously saved.

          Save (Hot Key = Ctrl + S)   - Saves the current course. Ask for a file name if the 

course is unnamed.
Save As... - Asks for a file name and location, then saves the current course.

Import Course Library - Allows a library to be imported so that it can be used in 

the Course Architect. When selected, a dialog box will appear allowing you to select the 
(.clb) library file. When the Open button is selected, the library will be added as a tab in 
the librarian.

Course Properties - Provides information about the course and allows the course 

to be named and resized.
Course Info - Shows the courses memory usage, number of objects, number of 

points, and other course related information.
Compile Course - Compiling your course creates a course that PGAC Golf can 

load and play. You must compile your course before you can play it. There are only a 
few options to compiling a course. It is possible to create your course with or without 
trees, bushes, and 3D structures. It is also possible to create your course without 
shadows. These options can easily be turned on or off simply by clicking the check box 
next to the option. The last options allow you to register your course with PGA 
Championship Golf so that it will be available for playing and testing. Each course 



played within the golf game uses textures, objects, structures, sounds, and panoramas 
that are stored in a course library. In order for a course to be played, the appropriate 
library or libraries must be loaded on your computer.

Most Recently Used Files - This section contains a list of the most recent files 

that have been open in the Architect. The list can contain up to four files and is useful in 
allowing quick access to previous course files. This list will be empty the first time that 
the Architect is launched after installing.

Exit (Hot Key = Alt + F4) - Requests to save the current course, then closes the 

Architect.



Game Menu
Choose Game from the Menu Options. The Game Menu provides an interface with the 
game options.

Main Menu (Hot Key = Ctrl + M) - Asks for confirmation to quit the current game, 

then returns to the Main Menu screen.
Options (Hot Key = Ctrl + O) - Opens the Machine Options screen. When you are 

done editing the options, you will be returned to the game.

Save (Hot Key = Ctrl + S) - Save the current game. If you have just taken a 

stroke, but haven’t selected Continue from the Button Bar, then the game will be saved 
as if Continue was selected.

Save As (Hot Key = Ctrl + A) - Save the current game. Opens a screen that 

allows you to name and select a location to store the saved game. If you have just taken 
a stroke but not selected Continue from the Button Bar, then the swing will be saved as 
well. You can then replay the swing by resuming the game.

Resume (Hot Key = Ctrl + R) - Resume a saved game or swing. Asks you for the 

name of the saved game file. Note: This will end your current game.
Delete (Hot Key = Ctrl + D) - Opens a window that allows you to select the name 

of the saved game file to delete.

Exit (Hot Key = Alt + F4) - Asks for confirmation to exit the execution of the 

application.



Game Options
The game options can be changed on the Game Settings screen. Select the level, play, 
rules and number of holes to play.

Click on the options to change the settings.

Level - Select the level of play.

Tournament - Intense competition feel for those trying to gain the status of a 

champion. On some courses, there will be galleries of people watching the round and 
announcers will give play by play commentary. The crowds will cheer when you make 
that long putt and sigh when it misses. It creates the feeling of being in a tournament 
and adds a little extra excitement to the round.

Recreation - Just hitting the ball around with a couple friends. You and your 

friends may comment on your shot but you won't have to deal with the packed crowds of 
a tournament.

Practice - Trying to gain some experience without being forced to follow the 

fairway. Only one person will be allowed to play. Using the entire course as a practice 
area or just hitting some balls at the driving range. Practice is recommended to those 
just starting out. No score is being kept, and you have a bunch of practice balls so 
swing away and hope no one is watching.

Play - Choose how competitively the game will be played.

Allow ReadyPlay™ - Allow players to go to their ball and swing whenever they 

want. This option greatly accelerates game play but should be turned off by the purists 
who want to force honors. Use the Camera Editor to select which player to follow.

Use Handicaps - Require each player to have a previously calculated handicap 

(play a round of 18 using Regulation rules.) The handicap of each player will be used to 



calculate the total score and determine the winner. The scorecard will show the 
handicap for each hole and the handicap for a team will depend on the type of play.

Sudden Death - Provides a way to resolve a tied round. If a tie occurs at the end 

of a round, the tied players will play an additional hole. The player with the best score 
for that hole wins the entire round. If players tie again, then additional holes are played 
until one player shoots a lower score.

All golfers play tournament tees - Force all players to start from the 

tournament tees regardless of which tees the player had previously selected. 
Tournament Tees are the furthest tee from the hole.

All golfers play advanced ability - Force all players to use the advanced ability 

level regardless of the ability level that a player may have previously selected. 
Advanced ability level is the most difficult to master.

Rules - Choose the rules to use during this round.

Regulation - Forces all the rules to be regulation rules. No mulligans or gimmies 

will be allowed, but statistics will be calculated. Each player must play at least one 
round of 18 using Regulation rules in order to establish a handicap.

Custom - Allows you to choose which of the following rules you wish to enforce 

during the round. Mulligans and gimmies will be allowed, but course and player 
statistics will not be calculated during the round. Players will not receive a handicap 
from a round of golf if this is selected.

Mulligans - Choose the number of mulligans a player can take. This option is not 

available if Regulation is selected.
Gimmies - Choose the distance from a hole that you will allow players to take 

gimmies. This option is not available if Regulation is selected.
Pickups - In some types of play you will be allowed to pickup your ball when you 

no longer have an opportunity to win the hole. If this rule is selected, you will be able to 
pickup the ball and head on to the next hole without holing out. This option is not 
available if Regulation is selected.

No stroke for missed ball - A penalty stroke will not be added when a player 

misses the ball. This option is not available if Regulation is selected.

Holes - Choose the number of holes to play. The options include the front 9, back 

9, 18 holes, and 72 holes (for those who just can't get enough satisfaction from an 
eighteen hole round). If level of play is practice, you can choose to go to the Driving 
Range, Chipping Area, Putting Green, or any hole on the selected course.



Game Settings
PGAC Golf allows you to customize a game in several ways. You will get to choose a 
course and its conditions, number of holes to play, the rules for the round, and what 
type of play to use.
To adjust settings for the round, select New Game from the Main Menu screen, then 
Choose Game.

Click on the text to view the selected settings.

Course - Select a course to play, if the course name is "Unknown", then you do 

not have the selected course and cannot continue from this screen.
Conditions - Choose the course conditions to play in.

Options - Set the rules to follow for this round.

Type of Play - Select a type of play for this round.

Back to the Choose Game screen.

Cancel to the Main Menu screen.

Next to the Who's Playing screen.



General Options
All of the game options discussed in this section are available from the opening Main 
Menu screen by clicking Options or during the game by selecting Options (Ctrl + O) 
from the Game Menu. This opens a screen with four sections: General, Sound, Course, 
and Golfer. Click General.

Ball Size - Adjust the ball size for easier viewing during play. This option will 

increase the size of the ball, but will not change the flight characteristics of the ball.
Continuation Delay - Set the number of seconds that elapse before the screen 

automatically redraws for your next shot. The default is None, therefore, you must 
manually continue via the Continue button in the Button Bar.

Chipping Stance - Set the number of yards from the green at which golfers will 

automatically switch to a chipping stance and use the preselected chipping club.
Varying Course Conditions - Select Never to have the conditions remain as you 

set them in the Game Settings screen. Selecting Sometimes or Always will change the 
conditions on the course randomly at the beginning of the round. The conditions will not 
change during a round or tournament.

Use Metric - The game and Course Architect will use the metric system in 

displaying distances.
Recommended Settings - Resets all options to the settings recommended for the 

current machine speed and ram requirements.



Getting Started
If PGA Championship Golf has been successfully installed, an opening screen will 
automatically appear when the CD is put into the drive. The opening screen will contain 
selections that will enable the game or the architect to be run.

If a full install has been done, PGA Championship Golf can be started without putting in 
the CD, there will be a shortcut in the Start Menu. Just select Programs | Sierra | PGA 
Championship Golf '99 and then:

PGA Championship Architect - to create or edit a custom course.

PGA Championship Course Manager - to run the course manager and install, 

move, and delete courses.
PGA Championship Golf - to run the game.

Context Sensitive Help is available within the interface throughout PGA Championship 
Golf. This feature can be accessed by the following methods which depend on the 
current mode of operation.

From the Help Menu by selecting 'On Item'

By pressing the hot key [F1]

By clicking the 

 button in the upper right corner of some windows

By clicking the Help button in the lower right corner of some windows

After selecting context sensitive help, click on the area of the screen in question.

Tool Tips are available and can be turned off using the Window Menu. Simply place the 
cursor over an icon to see the tool tip message.



Gimmies
A gimmie is a feature available for Custom Rules game play in the Game Settings 
screen on Options. It allows you (if your ball is a certain distance from the hole) to 
assume that your next shot will put the ball in the hole. This option is for cautious 
players who are not absolutely sure about making short putts, or for the confident player 
who wants to speed up the game play.

Select the distance from the hole to accept gimmies using the drop list.
6, 12, 18, 24, 30, 36 in - Allow players to take gimmies when their ball is within 

the selected distance to the hole.
None - Disable the option.

When the ball is within gimmie range, the Gimmie button is available on the Button Bar 
(assuming the option has been enabled) during a round. To use a gimmie, click the 
button, or select Gimmies (G) from the Action Menu.

Note: Statistics are not updated when gimmies are allowed.



Golfer Options
All of the game options discussed in this section are available from the opening Main 
Menu screen by clicking Options or during the game by selecting Options (Ctrl + O) 
from the Game Menu. This opens a screen with four sections: General, Sound, Course, 
and golfer. Click Golfer.

Golfer Detail - Determines the detail of the golfer on the screen (by the number of 

polygons used in the rendering of the golfer model). The High option will display a 
smoother, more detailed golfer, but it will take longer to draw on the screen. The lower 
options are recommended for slower machines. The quicker your golfer can draw, the 
smother the swing.

Golfer Shadow - Turn off the golfer shadow. This speeds up the golfer redraw 

rate.
Golfer Motions - Choose the frequency of golfer motions for yourself and other 

golfers. Choose from the following:
Ambient - Sway, scratch, yawn, and wipe sweat.

Shot Reactions - Reactions to the last swings quality.

Delay & Preparation - Impatient foot tapping, crouching to read the green and 

checking the wind.
User Initiated - Motions initiated by remote golfers on other machines.

Recommended Settings - Resets all options to the settings recommended for the 

current machine speed and ram requirements.



Grid
Choose when to show the grid for each player on the Player Settings screen. The grid 
options allow you to decide when the grid will automatically appear for the player being 
edited or created.

The auto show options are:
Never - The grid will never be displayed for the player.

Always - The grid will always be displayed for this player every time the game 

redraws a scene.
Chipping and Putting - The grid will only be displayed when the player is within 

chipping distance of the hole. It can be very helpful for finding the break or the lip of an 
obscured bunker.

Putting - The grid will only be displayed when the player is on the green. It can be 

helpful for finding the break of the green.

Note: The grid can be turned on and off manually regardless of the selected 

option by clicking the Grid button on the Button Bar or by selecting Grid (X) from the 
Action Menu.



Handicap
In general, a handicap is a number that would be subtracted from your average score 
for 18 holes to achieve a net score of par for the course. For example, someone with a 
handicap of 18 would normally shoot around 90 on a par 72 course. Handicaps affect 
your score in different ways depending on the type of play selected.

To establish a handicap in PGAC Golf, a player must first be playing with regulation 
rules selected from Options on the Game Settings screen. Then, choose one of seven 
types of play, Medal, Match, Stableford, Four Ball Match, Four Ball Medal, Four Ball 
Stableford, and Skins. Finally, the player must complete 18-holes in one sitting. A new 
handicap will be generated which considers the difficulty of the course and the player’s 
score for the round. The course difficulty can be viewed on the Scores screen during a 
game. The first number is the CourseScoreVelocity and the second number is the 
EffectiveCoursePar. The new handicap will be calculated using this formula:

((RoundScore    -    EffectiveCoursePar)    /    CourseScoreVelocity)

The players final handicap will be calculated using the players last twenty handicaps 
according to the following method:

Number of Handicaps Average of Lowest
1 - 6 1
7-16 (Number - 3) / 2
16-20 Number - 10

The handicap is continually tracked and updated for each player as subsequent rounds 
are played. Players must have established a handicap to participate in any game which 
has Use Handicap checked on Options in the Game Settings screen. The handicap 
that is used during the round will be adjusted considering the difficulty of the course 
being played. The handicap that is used will be calculated using this formula:

(Handicap    x    CourseScoreVelocity)



Hole Information
The Hole Definition Tool option allows you to define all of the positional information for 
the 18 holes, Driving Range, Putting Green and Chipping Area. Select Hole Definition 
Tool from the Tools Menu to open the dialog. Use this dialog in conjunction with the 
Work Window to select positions.

A hole is defined in the following order:
Select the hole number you want to define.

Select the tee positions (all tee positions must be on a tee-box.)

Select the shot path for the hole.

Select the pin positions (all pin positions must be on the green.)

Create the "out of bounds" segments."

Hole Number - Select the hole number to be defined. The par for this hole will be 

displayed to the right.
Driving Range / Putting Green / Chipping Area - To define a Driving Range, 

Putting Green, and Chipping Area, use the hole selection arrows and move past hole 
18. You will see DR, PG, or CA indicating that you are editing the Driving Range, 
Putting Green, and Chipping Area respectively.

Shot Path - The shot path is very important to the playability of the game. It is 

used for lining the golfers up for each shot and controlling the AI golfers path to the hole. 
Make sure the path is centered over the fairway from tee to hole and avoid putting shot 
points on unplayable terrain. If a hole requires golfers to hit over unplayable areas, put a 
shot point just before, and one just after the unplayable area. There is no relationship 



between the par of the hole, and the number of points needed in the shot path. For 
example, a dog leg par four hole might need ten points in the shot path while a straight 
shot par five might only need two. A good rule of thumb is to always define more points 
than you think will be necessary for the shot path. To define the shot path, just click 
once for each point that you want to add to the shot path. The last point should fall 
somewhere near the middle of the green.

Tee Positions - The Architect allows up to five tee positions to be defined for each 

hole; Tournament (black), Professional (blue), Amateur (white), Ladies (red), and 
Forward (yellow). The game requires that one of these tees be defined. Select the Shot 
Path radio button, then check which of the five tee positions you want to define. Finally, 
place the tees in the order that they are listed.

Pin Positions - Select this radio button to create the pin positions for the current 

hole. Any number of pin positions can be defined; there is no limit. The game will 
randomly choose a position each time the hole is played. To delete a pin, select it with 
the mouse, and hit the delete key on the keyboard. To move a position, click on it with 
the mouse and drag it to a new position on the green.

Out of Bounds - Define any number of out of bounds segments per hole. Select 

the Out of Bounds button and select New to create a segment. Define the segment by 
clicking in the Work Window to define the area that will be out of bounds. To create 
another segment simply click New again.

Instructions - Instructions are available at the bottom of the dialog. This area will 

tell you the current state of the dialog and what should be entered next.
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Welcome to PGA Championship Golf 1999 Edition
PGA Championship Golf is the latest addition to the popular series of golf games from 
Sierra Sports. To build on the success of our previous golf games, Front Page Sports: 
Golf and Sierra Sports Golf Pro ’98, we were convinced that it was important to advance 
in five main areas. First, we believe that many of you are would-be golf course 
designers, and we wanted to provide a powerful, yet simple, tool to allow you to create 
the courses of your dreams. Second, we wanted to bring your golfing companions to life 
on screen and put them within your view. Third, we felt that it’s time to get away from the 
old, turn-based game style. You need the freedom to move around, look about, and play 
at your own pace. Fourth, we wanted to thrust you into a setting that looks, feels, and 
sounds like an actual professional tournament. Fifth, we were eager to build on an 
already great swing control, TrueSwing™. 

Producing a course creation tool proved to be a very difficult task. It must have the 
power of a professional CAD package while being simple and easy to use. The key was 
to shift the complexity and burden away from you. Every tool is designed to take very 
few steps (often just one) and make tasks easy. And the tools have all the power 
needed to create beautiful courses. The result is a Course Architect that is limited only 
by your imagination. Now you and other course designers from around the world will be 
creating fantastic courses and allowing them to be downloaded and played for free.

Computer golf can be a lonely sport. Even when playing online with friends, you are 
able to see them only when it’s their turn. And at that point, the perspective isn’t from 
where you are, it’s from where they are. So we’ve brought your friends into view. Now 
you can see what the other golfers are doing, from your perspective. You can watch 
your buddy slice it into the trees or even taunt them with a choking gesture.

I believe that one of the most significant advances we have made is ReadyPlay™. Until 
now, all golf games have been turn-based. They render behind the player who is 
farthest away until they hit, then render behind the player next farthest away, and it's 
their turn. In PGA Championship Golf, we’ve taken the handcuffs off. You’re in control of 
the pace of play and where you look and stand. You can be sizing up your own putt 
while your partner makes theirs. In addition to making the game more flexible, it makes 
it much faster. Be sure to read the Swing Camera and Game Option sections of this 
manual and learn how to use these great features.

You now have the option of playing recreationally, for practice, or in a tournament. 
Television announcers, galleries, gallery sounds, bleachers, and all the other important 
aspects of a tournament are available. It may make you more nervous over your putts, 
but the added intensity is worth it. You can play tournaments online against hundreds of 
other people or against a field of computer players that you create or download.

Last year, TrueSwing™ set a standard in game control that has been universally 
accepted. Yet we felt that a number of improvements could still be made. TrueSwing™ 
has been balanced to shift some of the emphasis away from the need to move the 
mouse absolutely straight and toward concentrating on more strategic play. Shot 



shaping is easier and provides a great opportunity to improve your score by developing 
this skill. A new element of control has also been added, which requires you to return 
your mouse to the starting position to avoid off-center shots and mis-hits. Real golfers 
learn very early that one of the most fundamental challenges of a swing is to return the 
club head back to the ball. Several other features have been added that reward players 
who understand the game of golf and concentrate on every shot. Read the Analyze the 
Shot section for more details.

Thanks for purchasing PGA Championship Golf. I’m sure it will bring you many hours of 
fun and excitement.

Vance L. Cook



Land Shapes
The Land Shape mode can be selected from the Button Bar or the Tools Menu. Land 
Shapes begin in the Work Window as objects that float above the course. While they 
are floating, the points can be selected, pulled around, inflated, and rotated. Right click 
on the floating shape to get a menu of options to perform on the shape. Dropping a 
shape makes it part of the terrain. Once the shape becomes part of the terrain it cannot 
be resized or repositioned until it is picked up again. Use the following options to 
manipulate Land Shapes:

Create Land Shapes - Click the left mouse button on the Work Window and a 

new point will be added. Continue clicking until the new shape is complete. Double click 
the left mouse button to add the last point and finish the shape.

Delete Land Shapes - Select the shape by moving the cursor over it and click the 

right mouse button. Choose Delete from the menu that appears. The shape may also 
be deleted by selecting all the points and pressing the Delete key on the keyboard. 
Choose Delete with Children to delete both a dropped land shape and any other 
shapes that are positioned inside of the shape.

Modifying Land Shapes - The points on a land shape may be moved, deleted, 

and duplicated. When the cursor is moved over a point. it will change to a hand pinching 
the point. Be careful not to cross the lines since you cannot drop a shape with crossing 
lines.

Move A Point - Hold down the left mouse button, and drag the point to a new 

position.
Add A Point - Move the cursor over the point closest to the place you want to 

add another point and click the right mouse button. Select Duplicate from the menu that 
appears. This will create a new point between the selected point and it’s neighbor.

Remove A Point - Move the cursor over the point you want to delete and click 

the right mouse button. Select Delete from the menu that appears. A point may also be 
deleted by selecting it and pressing the Delete key on the keyboard. 

Rotating Land Shapes - Select all the points in an object and select Rotate from 

the Button Bar or the Edit Menu. A square with a cross in it will appear on the screen. 
This marks the spot around which all selected points will be rotated. Move this mark by 
clicking it with the left mouse button, and dragging it to a new position. Use Ctrl + Shift 
+ C to center the rotation point in the middle of the work window or use the View Menu. 
Rotate the points by holding down the left mouse button and dragging it around the 
screen. To finish rotating the points, select Rotate again. Interesting changes can be 
made to a shape by selecting only some of the points before beginning the rotate.

Dropping Land Shapes - Once the land shape is the right shape and size, it can 

be added to the terrain. This removes it from the group of floating shapes and makes it 
part of the land. To drop the selection, double-click inside a single Land Shape or right 
click on the shape and select Drop from the menu that appears. Land shapes cannot be 
dropped if they cross themselves or cross existing shapes in the terrain. To drop more 



that one object at a time, select Drop Selected Shapes from the Button Bar or Edit 
Menu. This will cause all shapes with any selected points to be dropped onto the terrain.

Picking Up Land Shapes - Land shapes must be picked up and made to float 

again in order to edit them or duplicated and moved somewhere else. To make the 
shape float again, right click on the dropped shape and select Pick Up from the menu 
that appears. Select Pick Up With Children to include all dropped shapes positioned 
inside of this shape.

Use as a Shape - Dropped Land Shapes can also be used to create floating 

Land Shapes that duplicate the dropped shape. Right click on the dropped shape and 
choose Use as a Shape from the menu that appears. A floating Land Shape will be 
created that is the same shape and properties as the dropped shape.

Shape Properties - To modify the shape properties, right click on the shape and 

select Properties… from the menu that appears. A dialog box will then allow you to 
change the texture or inflate/deflate the shape. There is also a checkbox that will allow 
you to change all the dropped shapes that have the same texture as the current shape. 
The texture will not become visible until the shape is dropped onto the terrain. The 
textures are color-coded indicating the playability of each texture; green (playable), red 
(unplayable), and blue (unplayable, but with a free drop). Inflating a shape will cause the 
edges of the shape to move outward while deflating the shape will move the shape 
edges inward.

Note: Once a shape is dropped, you can still change the texture type but you will 

not be allowed to inflate or deflate the shape until you pick it up again.

Note: A quick way of creating a fringe is to duplicate the fairway shape and then 

inflate the duplicate shape and change it’s texture to a fringe texture. The new shape 
can then be repositioned over the existing fairway and dropped onto the course.



Land Tools
The Tools Menu contains the land tools options which deal with elevation changes in the 
Course Architect. They give you the feel of molding and shaping the ground into hills 
and valleys, much like a potter works with clay. These tools provide ways of easily 
modifying the elevation of the terrain in a smooth and efficient manner. You can choose 
operations that make a hill or valley, a bunker or mound, a flat sided hill or valley (called 
slope), and smooth or flatten terrain. The Land tools are not available until conditions 
exist where the elevation change is applicable.

To specify what areas are to be affected, you must select Land Shapes. All of the 
elevation tools require at least one selected Land Shape. It is inside this land shape that 
the elevation tool modifies the terrain. In the case of Hills, Bunkers, and Slopes, you can 
select two Land Shapes. When using two Land Shapes, it is required that one of the 
Land Shapes be completely within the other Land Shape. In this case, the outside Land 
Shape indicates what terrain should be modified. The inside Land Shape changes the 
shape of the Hill, Bunker, or Slope that is created. These tools can be used to make 
both very large and sweeping changes, or very small and subtle changes.

 

 

 

 

Hill, Bunker & Slope tools - After selecting one of these tools, a dialog is displayed, 
asking for the desired elevation change. You can indicate whether the elevation change 
is up or down. An edit box is provided for exact elevation changes. Use the slider bar to 
change the elevation in a more intuitive and reactive way. The dialog is dismissed by 
clicking either the OK to apply or Cancel to ignore the change.

These tools are able to operate with one or two selected Land Shapes  .   If two shapes 
are selected, one of the Land Shapes must be completely inside the other shape. If only 
one Land Shape is selected, then the center of the shape will be raised or lowered. If 
two shapes are selected, then the inside shape will be moved the full amount requested 
The terrain that lies between the inside and outside Land Shapes will be moved at 
varying degrees to create the specified affect.



You must keep in mind that these tools make changes to the existing terrain. If the 
terrain is originally flat, it will make a recognizable Hill, Bunker or Slope. If multiple 
elevation operations are conducted upon the same land area, the result will be the 
aggregate, or combination, of all the changes made. Use the Camera Window to see 
real-time visual feedback. A grid will be displayed, indicating what the terrain will look 
like after each elevation change is made.

Note: Multiple land operations will begin to add redundant points to the course. 

Removing detail will increase performance without reducing the visual quality.



Librarian
Course libraries are collections of things that can be placed on the course. Trees, 
bushes, rocks, ball washers, bridges, stairs, and sounds are all stored in course 
libraries. The architect can only use objects that are found in course libraries. If custom 
objects are to be used in a course they must first be compiled into a course library. The 
architect comes with several pre-built course libraries.

Open Library - Select Library from the View Menu or Button Bar. The librarian 

will appear, containing one page of items for each library registered on the machine.
Close Library - Select Library again or use the standard windows close icon in 

the upper right corner of the library window.
Add Object - Move the cursor over an object in the Library View and hold down 

the left mouse button. Drag the object over the Work Window and place it by releasing 
the button. This will drop the object onto the course. To place many objects of the same 
type, use the Click-Click or Foresting Tool methods.



List Editor
Create or edit a list of computer controlled players. This list can be used to create large 
tournaments where you can compete with your favorite PGA player. First enter a name 
for the list you are creating in the upper right corner of the screen.

Create, edit and delete players before you select them into the list. There are three 
buttons that allow you to manipulate the players.

Create Player - Create a new player using the Player Creation screens. The 

button is available on the lower left portion of the screen. All players created here will 
automatically be computer players.

Edit     Player   - Edit the current highlighted player. This button is only shown when a 

player has been highlighted.
Delete Player - Asks for a verification, then deletes the highlighted player and all 

their statistics. Saved games will still contain the player, but they will no longer be 
available for a new round. This button is only shown when a player has been 
highlighted.

There are two list boxes in the screen, one for the Available Players and one for the 
Selected Players in the list.

Available Players - This box contains a list of players that have been created but 

have not been selected into the list. When a new player is created, an entry for that 
player is added to this list. The entry consists of the player name, followed by the 
handicap. The handicap will be followed by C for computer players.

Selected Players - This list box contains the selected players that will be 

contained in the list. The Add/Remove button affects who is displayed in this list. When 
a player is added to this list, they are no longer displayed in the Available Players list. 
The entry consists of the player name, followed by the handicap. The handicap will be 
followed by C for computer players.

There are two methods for moving players between the Available and Selected Players 
lists.

 Double-Click - Double-Click directly on the name and it will change lists.



Add/Remove Button - Click once to highlight the name. Then use the 

Add/Remove button. The button is displayed in the center of the dialog only when a 
player's name is highlighted. The name of the button will change depending on whether 
the selected player can be removed or added.

Cancel to the Who's Playing screen.

Finish to create the list of players and return to the Who's Playing screen.

Note: To move players from one list to another, edit the first list by removing the 

players in question, then edit the second list by adding those players to it. To share lists 
with others, locate the directory named after the list in the PGAC Golf / Players 
directory. Then copy the list to another machines PGAC Golf / Players directory.



Machine Options
PGAC Golf will be automatically configured for ideal performance on your machine 
during installation. These options allow you to manually configure PGAC Golf should 
you prefer to run it differently on your machine.
To customize the game options, select Options from the Main Menu screen. This 
screen will appear, giving four types of options available for customization:

General - Set general play characteristics.

Sound - Customize individual sound events by choosing the interval of play.

Course - These options can change the rendering speed and the quality of the 

scene.
Golfer - These options can be adjusted to speed rendering or improve the look of 

the golfer.
Recommended Settings - When the game is started for the first time, PGAC Golf 

will analyze the machine and recommend settings that will give the best performance for 
the machine. After changes have been made, if you want to return to the default 
settings, select this button.

Click OK or Apply to accept the settings.

Click Cancel to ignore the settings and return.

Note: Changing the machine settings may increase or decrease the 

performance. If your performance is unacceptable, use the recommended settings or 
see the trouble shooting section.



Main Menu
The Main Menu is the starting point for each game. To get back to the Main Menu 
during a game, just select Main Menu (Ctrl + M) from the Game Menu.

Select an option by clicking on the text.

Quick Start - The Quick Start option will allow you to skip the setup screens and 

begin playing immediately. It starts a new round using the setup options from the last 
game that was played. Default players are shipped with PGAC Golf so you can utilize 
Quick Start the very first time you load the game.

New Game - Opens the Choose Game screen to choose between local, LAN 

(Local Area Network), or Internet games. This begins a new game.
Resume Game - Opens the Resume Game screen to resume a previously 

saved game or shot.
Stats - View the stats of current players and currently installed courses.

Options - Opens the machine Options screen to customize the settings for 

rendering and sounds.
Preview - Opens the tutorial on PGAC Golf. You will need the installation disk to 

run the preview.
Help - Starts context sensitive help.

Exit - Terminate the application.



Menu Options (Architect)
The pull down menus at the top of the application window provide options for course 
creation. These options are available when there are no modal windows being used. 
The menus are:

File - Contains options like creating, saving, and exiting a course.

Edit - Edit the selected object or undo your last action.

View - Contains options to show or hide the button bars and move or zoom into 

the Work Window.
Tools - Contains options to create or edit shapes and objects in the Work 

Window.
Window - Lets you select alternate ways to view the course and its elements.

Help - Opens the on-line help manual and provides About information.

Contents (Hot Key = F1) - Opens the on-line help manual beginning with the 

Contents page.
On Item (Hot Key = Shift + F1) - Displays the context-sensitive help cursor. 

Click anywhere on the architect interface to get help on that item.
Keyword (Hot Key = Ctrl + K) - Opens the on-line help manual in keyword 

search mode.
About - Displays an information box about the Course Architect and the current 

systems resources.



Menu Options (Game)
The pull down menus at the top of the application window provide options for game 
execution. These options are only available during game play. The menus are:

Game - Contains options like saving and exiting a game.

Practice - Is only available in the practice areas. It allows the player to switch 

between practice areas.
Driving Range - Starts the player on the driving range of the selected course.

Putting Green - Starts the player on the practice putting green of the selected 

course.
Chipping Area - Starts the player on the practice chipping area of the selected 

course.
Hole 1 - 18 - Starts the player on the hole selected.

Remote - Is only available during remote games. It allows players to send text, 

comments and golfer motions to other players.
Tolerate High Latency - If the game is frequently terminated due to a slow 

connection, you will want to allow a higher tolerance. Select this option to allow slow 
remote connections.

Message1 (Hot Key = F5) - Opens the last messages saved in this slot.

Message2 (Hot Key = F6) - Opens the last messages saved in this slot.

Message3 (Hot Key = F7) - Opens the last messages saved in this slot.

Message4 (Hot Key = F8) - Opens the last messages saved in this slot.

Message5 (Hot Key = F9) - Opens the last messages saved in this slot.

Message6 (Hot Key = F10) - Opens the last messages saved in this slot.

Message7 (Hot Key = F11) - Opens the last messages saved in this slot.

Hurry Up (Hot Key = F12) - Opens the hurry up message box.

Clear Messages ( Hot Key = Delete) - Delete the current messages on the 

screen.
Action - Provides a menu version of the game interface and all the options on the 

Button Bar.
View - Provides an interface for showing alternate views. In addition to the Swing 

Camera, you can open other cameras that provide alternate views of the shot you or 
your opponent are taking.



Window - Provides options to save the window configuration and placement.

Help - Opens the on-line help manual and provides About information.

Contents (Hot Key = F1) - Opens the on-line help manual beginning with the 

Contents page.
On Item (Hot Key = Shift + F1) - Displays the context-sensitive help cursor. 

Click anywhere on the game interface to get help on that item.
Keyword (Hot Key = Ctrl + K) - Opens the on-line help manual in keyword 

search mode.
About - Displays an information box about PGAC Golf and the current system's 

resources.



Mulligans
A mulligan is a feature available for Custom Rules game play in the Game Settings 
screen on Options. A mulligan allows you to re-hit your last shot without penalty. 
Mulligans are useful for keeping a bad shot from affecting your score. They can also 
add to the strategy of a game if you have a limited number of mulligans.

Select the number of mulligans for each round using the drop list.
All - Always allow mulligans.

2, 4, 9, 18, 36, and 72 - Allows a limited number of mulligans per player.

None - Disable the option.

After the ball has been hit, a Mulligan button is present on the Button Bar (assuming the 
option has been enabled and you still have mulligans remaining). To use a mulligan, 
click the button, or select Mulligan (M) from the Action Menu. Remember to keep track 
of how may mulligans you have remaining.

Note: Statistics are not updated when mulligans are allowed.



New Course
To create a new blank course, select New from the File Menu. The process of creating a 
course from scratch can be fairly tedious so in order to save time, select New Course 
Wizard from the File Menu. This will lead you, step by step, through the creation of your 
course. The wizard is meant to be used to start your course, the menu item will be 
grayed out once the course creation has begun.

The purpose of the wizard is to allow you to quickly:
Lay out any number of holes (up to 18)

Apply textures to the terrain shapes that make up each hole (rough, fairway, etc.)

Create any water objects on the course.

The wizard uses Next, Back and Cancel buttons to navigate through the dialogs. The 
very last page has a Finish button, instead of Next. Finishing the wizard moves the 
work done in the wizard to the Work Window where it can be manipulated in the same 
manner as any other object. Each wizard screen has a top view of the course on the left 
side, and customization controls on the right. The screens are as follows:

Wizard Screen: Welcome - Explains the usage of the wizard. The wizard will 
automatically be displayed when the Architect is launched for the first time. Use the 
checkbox on this screen to force the wizard to be displayed each time the Architect is 
run.

Wizard Screen: Main Texture - Select the main texture to use throughout the course. 
The selected texture will be visible outside of any terrain objects. The drop down combo 
box is used to choose the texture. When a texture is selected, the wizard's editing 
window will reflect the change. Textures listed in green are playable, meaning that if the 
ball lands on it in the game, no drop is required. Textures listed in red are unplayable, 
meaning that the game will require the player to drop on the nearest playable texture, 
with a penalty. Those listed in blue are unplayable but allow free drops, meaning that 
the game will require the player to drop, but without a penalty (used typically for areas 
such as cart-paths).



Wizard Screen: Water - Create water objects for the course. Move the cursor over the 
wizard’s editing window, click and hold down the left mouse button, draw out the water 
object, then release the left mouse button. A line will be drawn by the cursor that follows 
it's movements. When the mouse button is released, the line is closed by connecting the 
last point with the first point. The area is then filled with blue. To delete a water object, 
select it by clicking on it, then press the delete button.

Be careful when drawing the water object, these cases will not be allowed:
Lines cannot cross over themselves.

Lines cannot cross over other water or holes.

Lines cannot entirely encompasses other water or holes.

Lines cannot be too small (only a few pixels big).

Wizard Screen: Holes - The Hole page is used to create the holes that make up the 
course. It is not necessary to create the holes in succession or to create all 18 holes. 
The up and down arrows next to the hole number can be used to select the hole to 
create. Once the hole is created, the Created check box will be selected and the 



information in the Hole and Course sections will be updated.

You will only be allowed to create par three, four, and five holes. Follow these directions 
to create the following:

Create a Par Three - Move the cursor to the desired tee-box position and click 

the left mouse button. Then move the cursor to the desired green position and click the 
right mouse button.

Create a Par Four - Move the cursor to the desired tee-box position and click the 

left mouse button. Move the cursor to the position where the tee-shot should land and 
click the left mouse button again. Then move the cursor to the desired green position 
and click the right mouse button.

Create a Par Five - Move the cursor to the desired tee-box position and click the 

left mouse button. Left click on the position where the tee-shot should land, then click 
again where the second shot should land. Finally, move the cursor to the desired green 
position and click the right mouse button.

The wizard does a lot of checking, during and after the creation of a hole, to make sure 
that the holes are allowed to be drawn at the specified position. Holes are not allowed to 
do the following:

Holes cannot cross over themselves.

Holes cannot cross over other water or holes.

Holes cannot entirely encompasses other water or holes.

Holes cannot be any closer than half a hole’s width to any other object or to the 

edge of the course.
As a hole is created, a line will be drawn from the last point defined for a hole to the 



current position of the cursor. If the line is shown as black, it is okay to place a part of 
the hole where the cursor is. The line will turn red if it is not okay to place a part of the 
hole at that position.

Allowed Not allowed 

The information contained in the Hole section, such as the Shot Yardage, is updated as 
the hole is created. The information in the Course section is updated after each hole is 
created. To delete a hole, select it by clicking on it, then press the Delete button. During 
the creation of a hole, the Delete button changes to a Cancel button. Use this to cancel 
the creation of the hole at any time.

Note: When using the wizard, sometimes you may create a hole whose objects 

cross over themselves. If any of the shapes that make up the hole (fairway, fringe, 
green, etc.) cross over any of the hole’s other shapes, then the hole is not allowed. 
Since the resolution of the wizard’s editing window is so small (one pixel represents just 
over a five-by-five yard), it’s sometimes hard to tell that a hole’s shapes are crossing 
each other. When using the wizard, we recommend that you stick to creating holes that 
don’t have too many drastic angles in them, then adjust the holes using the land tools in 
the Tools Menu.

Wizard Screen: Shape Textures - Specify the texture of each part of a hole or water. 
Select them from the drop down list provided on the screen. They are color-coded 
indicating the playability of each texture; green (playable), red (unplayable), and blue 
(unplayable, but with a free drop).

Wizard Screen: Finish - When the Finish button is pressed from the final screen, the 
wizard takes all the water objects, holes, and textures, and draws them in the Work 
Window. Use the Navigation or Camera Windows to examine the new holes.



New Game
Select New Game, from the Main Menu. A sequence of interface screens will follow 
which will allow a game to be customized and then started. These screens will include 
the following information:

Choose Game - Choose between local, LAN (Local Area Network) or Internet 

connections. This is the beginning point for starting or joining remote games.
Game Settings - Select the course, conditions, and rules for a round of golf.

Who's Playing - Create, edit and delete players, then select who will be playing.

Create Teams - In team play, you will be able to group the players into teams.

The setup screens are in a wizard format (Back-Next windows). There are several 
screens in the wizard. The choices you make within these screens will take you to 
additional sub-screens. Make your selections, then click either Back, Cancel, Help, or 
Next to continue.

Back will take you to the previous screen.

Cancel will return you to the Main Menu screen.

Help will start context sensitive help.

Next will allow you to continue customizing a new game.

Clicking Play from the final screen will start the round of golf.

Note: You can navigate past this entire area by selecting Quick Start from the 

Main Menu.



Object Placement
Object Placement can be initiated using the Button Bar button  or select the Foresting 
tool in theTools Menu. This will allow you to add objects such as trees or rocks to the 
course. Once an object has been selected from the library, it will be place on the course 
each time the left mouse button is clicked over the Work Window. The Done button on 
the placement dialog must be pressed in order to finish placing objects.

Once the objects have been placed, they can be selected again by moving the cursor 
over them and clicking the left mouse button. All other selections are removed and the 
new item is selected. To keep increasing the number of selections, hold down the Ctrl 
key while clicking on items. To deselect all objects, move the cursor away from all 
objects and click the left mouse button. A rectangle may be used to select several things 
at a time. To do this, move the cursor to the top left corner of the rectangular region to 
be used and hold down the Shift key while clicking the left mouse button. Now drag the 
cursor to the lower right corner of the selection area and release the mouse button. To 
select all the objects or sounds of the same type, hold the Control key down and 
double-click on an object or sound. All the objects or sounds of the same as the one 
clicked on will be selected.

There are three types of objects that can be placed in the course, two dimensional, 
three dimensional, and sound objects. Most objects are represented as two dimensional 
images in the course. These objects include trees, ball washers, textures, and flowers. 
Some objects such as bridges, houses and walls must be three dimensional. Each type 
of object has a unique method of placement.

Two Dimensional Objects - The two dimensional objects can be selected from the 
Objects section in the Librarian. There are three ways these objects can be placed. The 
first method is the Click-Click Object placement tool, second is the Foresting Tool, and 
finally, drag and drop the object from the librarian into the Work Window.



Click-Click Placement - Allows you to quickly place objects at specific locations 

on the course. The Click-Click tool can be accessed from the Button Bar, or the Tools 
Menu. Choose an object type from the dialog that appears by clicking the Object 
button. You can modify the settings on placed objects. Change the height of the object 
by moving the slider bar until the desired height is achieved. When placing many of a 
particular object it is sometimes desirable to have some variation in the height of the 
objects. Just choose a distance (plus or minus) that the object height can vary. You can 
also change the units to facilitate placement of both small and large objects. While this 
dialog is showing, you can click any where in the Work Window to place objects. The 
cursor will indicate that your are in Click-Click object placement mode.

Foresting Tool - When placing objects, you may want to place many objects in an 

area where the specific placement of the object is not important. Use this to forest an 
area or place flowers in a flower bed. First create and select a Land Shape where the 
objects should be placed. Then choose Foresting Tool from the Button Bar or Tools 
Menu. Choose an object type from the dialog that appears by click the Object button. 
The Librarian will appear and you can choose the object you would like to place. In the 
dialog you can specify the height of the object, any variation to the height, and an 
average distance between the objects. Apply will populate the selected land shape with 
the selected object type. This can be done several times if more objects are desired in 
the area.

Once placed, these objects can be moved, deleted and rotated.
Select Objects - Click on the object. A wire frame will be drawn around the object 

to indicate that it has been selected. To select all of one kind of object, hold the Control 
key down and double-click on the desired object. All of the objects that are the same as 
the object that was clicked on will be selected. To select objects in one area, drag a 
selection rectangle around the objects.

Delete Objects - Select the objects you wish to delete and right click on an 

object, then select Delete from the menu that appears or select the objects and hit the 
Delete key.

Move Objects - Click on the object, then drag it to a new location.

Rotate Objects - Select the object(s) and choose Rotate from the Button Bar or 

Menu Options.
Properties - Once an object has been dropped onto the course, it’s properties 

can be modified by right clicking the object and choosing Properties… from the menu 
that appears. This will cause a dialog box to appear that is unique to the selected item. 
You can modify the height of the object from this dialog. If more than one object is 
selected, the Properties dialog values will apply to all of the selected objects. The 
values displayed in the dialog will be the average of all the selected objects.

Note: If the mouse cursor is moved over any entry in the Librarian and held there 



for a moment, a tool-tip will appear that gives the title of that object. In the case of 
textures, the tool-tip will also list whether or not a texture is playable, and if a free drop 
is allowed.

Three Dimensional Objects - The three dimensional objects can be selected from the 
Structures section in the Librarian. These are three dimensional renditions of objects 
that cannot be represented by a photo. Some of these items are club houses, bridges, 
benches, houses, shacks and other miscellaneous items. These objects are never 
placed in mass as more care needs to be given to their placement. To place one of 
these structures on the course, click and hold on one of the structures in the Librarian. 
Then drag the object off the librarian and place it on the course. Once a structure is 
placed on the course several things can be done to modify it’s position and orientation.

Select Structures - Click on the structure. A wire frame will be drawn around the 

structure to indicate that is has been selected.
Delete Structures - Right click on the structure, then select Delete from the menu 

that appears or select the object and hit the Delete key.
Move Structures - Click on the structure, then drag it to a new location.

Rotate Structures - Changing the orientation of the structure, so it faces a 

different part of the course is simple to do. Select the structure, then choose Rotate 
from the Button Bar or Menu Options.

Properties - Once a structure has been dropped onto the course, it’s properties 

can be modified by right clicking the object and choosing Properties… from the menu 
that appears. This will cause a dialog box to appear that is unique to the selected item. 
You can adjust the elevation and scale of the structure. The elevation is useful for 
suspending bridges between two points of land or putting a building into the side of a 
hill.

Sound Objects - The sound objects can be selected from the Sound section in the 
Librarian  .   These are sounds that should be played at specific locations. They include 
sounds such as birds, waterfalls, and other ambient sounds.

Position Sounds - Click on the sound from the Librarian and drag it onto the Work 

Window.
Select Sounds - As with Two Dimensional Objects, you can right click on a 

sound to select it, drag a selection rectangle around it, or press the Control key as you 
right click or double click a sound.

Properties - Once a sound has been dropped onto the course, it’s properties can 

be modified by right clicking the object and choosing Properties… from the menu that 
appears. You can change the properties for more than one sound at once. The values in 



the Sound Properties dialog can be applied to all the currently selected sounds. The 
Sound Properties dialog contains the following options:

Original Sound - Shows an image representing the currently selected sound. If 

multiple sounds are selected and they are of different types, this option will be disabled.
Play - Plays the currently selected sound.

Stop - Stops the currently selected sound.

New Sound - When the dialog is first displayed, this button will be blank. Press it 

to bring up the Librarian. Select any one of the sounds from any of the libraries and the 
New Sound button will show an image representing the new sound.

Play - Plays the new sound.

Stop - Stops the new sound.

Position - Select the position and range of the sound.

Height - Select the source height of the sound. This is useful for birds in trees. 

Selecting Apply Height to all will move all selected sounds to this height.
Radius - A sound can only be heard within its specified radius. To make a sound 

audible everywhere on the course, make the radius as large as the course. Selecting 
Apply Radius to all will change all selected sounds to this radius.

Playback - Select the play back options for the sound.

Loop - Select this check box to run a sound continuously. Selecting Apply Loop 

to all will change all selected sounds to looping.
Frequency - Control when the sound gets played. The game will check all 

nearby sounds to see if they should be played. The chance that a sound will be played 



ranges from 0 to 100 percent. Once a sound gets played the game waits another couple 
of seconds before trying the nearby sounds again. Use the frequency slider bar to 
control how frequently the sound is played. Selecting Apply Frequency to all will change 
all selected sounds frequencies.

Note: When the Sound Properties dialog is first displayed and there are multiple 

sounds selected, the values displayed in the dialog are averages of the values of all the 
selected sounds.



Path Shapes
Select the Path Shapes mode from the Button Bar or the Tools Menu. A path shape is 
defined by a segmented line. The edges of the path run along side the central line and 
squarely across the end. The sides of the path are always parallel to the central line 
segment. When a path shape is dropped onto the terrain it follows the elevation 
changes in the terrain. No check is made to verify that a golf cart could actually navigate 
the path nor is the terrain leveled underneath the path.

Create Path - Clicking the left mouse button on the Work Window will add the 

starting point to the new path shape. Each mouse click will add a new point to the path 
shape line. Double click the left mouse button to add the last point and finish the path 
shape. Be careful not to let the edges of the path cross itself or it will not be allowed to 
drop. 

Delete Path - Move the cursor over the path to be deleted and click the right 

mouse button. Select Delete from the menu that appears. The shape may also be 
deleted by selecting all the points and pressing the Delete key on the keyboard.

Properties - The paths shape properties can be modified by moving the cursor 

over it and clicking the right mouse button. Select Properties… from the menu that 
appears. A dialog box will appear which can be used to change the texture and the 
width of the path. The texture will not become visible until the path shape is dropped 
onto the terrain.

Note: A path shape is really only a segmented line with a texture appropriate for 

a cart path. It can also be used to create other paths such as cement sidewalks or 
flower bed edging.



Player Ability
The player ability can be selected from the Player Settings screen. There are four 
choices for player ability:

Basic (Average 230 yard drives)- The distance and direction of the ball are 

scaled to make it easy for beginners. It is harder to hit a bad shot than a good one in 
this mode. This is a good place to start for younger golfers and beginners.

Standard (Average 250 yard drives) - The distance and direction of the ball are 

scaled to make this a good stepping stone toward an advanced ability level. It is still 
easy to hit a good shot, but it’s just as easy to hit a bad one.

Advanced (Average 275 yard drives) - The distance and direction of the ball are 

not scaled in this option. This swing option should be the ultimate goal of a computer 
golf master. All players in a tournament are set to this ability level.

Computer - Makes this player a computer controlled player with the ability 

selected above.

Note: In many other sports titles, creating an advanced player will result in a 

player having advanced abilities regardless of the ability possessed by the user. In 
PGAC Golf, the advanced players have no inherent ability, which requires you to make 
up the difference. But for those of you who have not acquired the skills it takes to be 
advanced, we offer basic and standard players who do have inherent ability that will 
help you compete with the pros.



Player Editor
Change the visual appearance of the golfer with these controls. To select the player 
editor, click on the Create Player button on the Who’s Playing screen, or highlight a 
player and select the Edit Player button. You will then be taken to a series of player 
customization screens. This is the second screen to appear.

Click on the text displayed in the center of the screen. This will allow you to 

change the colors, textures, and styles for that part of the golfer. You can select new 
textures by clicking them on the right side, or scrolling through styles and accessories 
using the left and right arrows on either side of the golfer.

Hair - Select the color of hair, and scroll through different hair styles.

Hat - Select the color of hat, and scroll through different hat styles.

Face - Select the facial features you want your golfer to have.

Top - Change the shirt pattern, and scroll through different shirt styles.

Bottom - Change the colors and apparel for the lower half of the golfer.

Trim - Change the clothing's trim color.

Shoes - Select shoes for the golfer.

Ball Marker - Select the color of the ball marker used exclusively on the green. 

The ball marker will show the current position of the players ball.
Male/Female - We think you can figure this option out for yourself.

Redress Per Round - Just before each round of golf, your player will choose new 

clothing to wear. After all, you can't be caught in the same outfit twice.

Back to the Player Settings screen.

Cancel to the Who's Playing screen.

Finish to create the player and return to the Who's Playing screen.



Next if this is a computer player.



Player Settings
To select the player settings, click on the Create Player button on the Who’s Playing 
screen, or highlight a player and select the Edit Player button. You will then be taken to 
a series of player customization screens. This is the first screen to appear.

Customize the player settings by clicking on the controls.

Player Name - Feel free to enter the name of your favorite pro then prepare to 

assume their talents.
Tees - There are five different tees (the starting point on any hole) available.

Ability Level - This option allows you to specify the difficulty required to execute 

the desired shot.
Control Method - There are three methods of swing control available. The 

traditional Tri-Click swing, which takes three mouse clicks to swing. The PGAC Golf’s 
Interactive TrueSwing™, which reads mouse movement to control the golfer’s swing. 
The Interactive TrueSwing™ is available in both vertical and horizontal mouse 
movements. Tri-Click masters may initially find their accuracy slightly decreased as they 
switch to TrueSwing™, but with a little practice, the increased level of control and the 
feeling of actually swinging the club will more than make up the difference. We strongly 
recommend TrueSwing™.

Show Grid - In order to better read the break of a putt or see the slope of the 

terrain, a grid can be displayed over the immediate area.
Caddie - If checked, the caddie will suggest a club at the beginning of the 

player’s turn, otherwise, a driver will come up at the beginning of the hole, the selected 
chip club will come up just off the green, and a putter will come up whenever the player 
is on the green. If a different club is desired, you will need to select the desired club 
before each shot.

Chipping Club - You must choose the default club to use for chipping. You can 

choose any of the irons as your default chip club. If you do not have the iron in your 
bag, then the closest club will be used instead.



Clubs In Bag - There are 21 clubs available to each player; however, only 14 of 

those clubs can be used at any one time - 13 clubs plus a putter. This option allows you 
to select the clubs the player will carry onto the course. Each club has specific 
properties associated with it that should be taken into account when selecting the clubs.

Suggest - This recommends the club selection for the default set of 14 clubs.

Cancel to the Who's Playing screen.

Next to the Player Editor screen.



Playing Golf
Once the game application has started, press any key or click on the screen with your 
mouse to dismiss the introductory movie.

The interface is in Wizard format which will lead you through the process of starting a 
game. The general process is as follows:

Main Menu - This is the first screen to appear. This is the starting point to the 

interface used to start a game.
Choose Game - Select between local and remote games.

Game Settings - Choose the course conditions and rules to play by.

Create Players - Create a player to add to the game. Choose name, clothing, 

ability and other attributes for your player.
Who's Playing - Select the players who will be playing in the game.

At the end of the interface Wizard, the game will begin. Other players might take their 
turns before your player but eventually you will be at the tee. The general game play will 
go as follows:

Menu Options - Use these options to make selections and customize the game.

Create Cameras - Put cameras on your competitors, make multiple views of the 

course, or change existing views of yourself.
Use the Swing Camera Interface - The Swing Camera contains the control 

interface for playing the game.
Analyze The Shot - Check the conditions and distance to the area you want your 

ball to land, and adjust the aim, club and golfer's stance.
Swinging The Golfer (TrueSwing™ or Tri-Click) - Take the shot using the player's 

control method.

PGA Championship Golf   (Philosophy)   - In the game of golf, professionals are 

separated from the rest by their ability to evaluate a shot and execute it. Evaluating a 
shot includes judging wind speed and direction, analyzing the distance and elevation of 
the pin, considering the lie, and calculating the break of the green. Executing that shot 
includes motor coordination, which can be the most difficult part. With PGA 
Championship Golf, we have created a simulator that allows you to control both of these 
characteristics. How well your player does depends directly on your ability to evaluate a 
shot and master the swing. Whether you are using Tri-Click or TrueSwing™, your 
knowledge of golf and the accuracy of your swing is what will ultimately win the round.



Putting and Chipping
Putting and chipping methods are different from swings taken from the tee. Both use a 
different method for Swing Power and putting reacts differently to Lateral Movement. 
The result is that you will have to use more touch on your stroke.

Swing Power - The distance the ball travels depends largely on the backswing. 

The further the club is pulled back, the greater the momentum of the club head and the 
further the ball will travel. To hit a short putt or chip, pull the club back slightly and swing.

Lateral Movement - The putter does not impart lateral spin on the ball. The effect 

is that the ball will travel in the direction it is hit. You will have to be careful about lining 
up your putt according to the break of the green. To do this use the grid  .   Not getting the 
club center back to the ball will produce the same results.



Remote (Internet)
The Internet is a great resource for gamers looking for a good round of golf against an 
opponent across town or across the globe. To play over the World Opponent Network 
(WON), you will need Internet access though an online service or through an 
independent service provider (often referred to as an “ISP”). You will need to have a 
working Internet SLIP/PPP connection that supports WinSock32 to play PGAC Golf 
over the Internet. You should also have at least a 14,400 baud modem, although a 
28,800 baud modem is strongly recommended. Contact your ISP or online service if you 
are unsure whether they provide this type of Internet access or if you have questions 
regarding how to connect to the Internet. Some Internet connections can be initiated 
automatically by the World Opponent Network (WON) through Windows; if you have 
problems using this method, connect to the Internet through your ISP before attempting 
to play PGAC Golf over the Internet.

The WON Validation Screen - When you select Internet from the Choose Game 
screen, you will see your computer begin connecting to WON. When your machine is 
connected to WON, you will see the WON login screen. Here you should enter a user 
name and password which you will use when you play PGAC Golf and other games 
over WON. (If you have already played another game over WON, you can use the same 
user name and password that you used for that game.)

Click Enter from the WON validation screen to begin.

Select New Member if you have never logged on before.

Enter a user name and password.

Select Exit to return to the Choose Game screen.

The WON Gathering Place - In the WON Gathering Place, you can send messages to 
other players and host or join a game. The Gathering Place is divided into rooms and 
you can enter the rooms by double clicking on them or selecting the Join Room button. 

The WON Rooms - There are three statistics rooms, one room for each available 
course, and many other user created rooms.

Statistics Rooms - Any game played in these rooms WILL affect the player's SGA 

statistics and rankings. These can be viewed in real time on the SGA web site, 
http://www.won.net/sga. The statistics rooms are the Tournament, Ladder, and Free For 
All rooms.

Tournament Rooms - The game settings are preselected by the creator of the 

Tournament room. Every game that is played within this room will have these settings. 
Scores and stats for a round will be displayed in real time on WON's Tournament Page. 
The players career stats and handicap are updated. During a Tournament, all scores 
can be seen on the in game Leaderboard.

Ladder Room - After playing a ladder game, you will be ranked according to 

other players. To advance up on the SGA Ladder, players must issue challenges to 



other players who are higher up on the ladder. A challenge can only be issued to players 
who are within ten rungs of the challenger. A challenge is issued through the SGA’s 
Ladder Page. Once the challenge has been accepted, the two players face off in the 
ladder room. If the challenger loses, his position on the ladder remains unchanged. If he 
wins, he moves up to the rung that his opponent held and his opponent drops down one 
rung.

Free For All Room - Players can play on any course in this room and also 

choose some of their own game settings. These games will affect your online statistics.
Course Rooms - Games played in these rooms will NOT affect the player's SGA 

statistics or rankings. There is a room dedicated to each of the provided courses. You 
can enter rooms which are using a course that you do not have installed on your 
machine, but you will not be able to play a game on that course without first installing it.

The SGA (Sierra Golfing Association) The SGA is an organization that provides the 
following services to its members:

Online Handicaps

Career Stats

Regular Tournaments with prizes

Ladder Rankings

SGA Certified Custom Courses

Golfing Tips

And MORE!

Available Games When you have entered a room, you will see all of the players who 
are in the room with you, as well as any games that have been started. The room will 
refresh periodically.

Start Game - Click the Create Game button, then choose a name and select 

details about the game, such as how many players you will allow to join. Once the game 
has been created, you can either wait for players to join your game or invite other 
players in the room to join. When at least one other player has joined your game, click 
Start Game to begin the game. The game will start automatically if the maximum 
number of players that you chose to allow to play have joined your game.

Join Game - Select the one you want to join and click the Join Game button. The 

Game Host can then accept or decline your request to join the game, or if you are a late 
comer, you will be able to join the game already in progress but will not be playing with 
other players. If the game has already started, then choose to join the game when 
prompted.

Watch Game - Select a game that has already started and click the Join Game 

button. Choose to watch the game when prompted.



Hosting and joining a remote game are similar for all connection methods.

Note: More details about WON and the Gathering Place are available through the 

WON online help feature (requires a Web browser to view) or the WON web site 
(www.won.net). If you encounter problems connecting to WON or playing a game, try 
the suggestions in the online WON help or contact technical support.



Remote (LAN/Modem)
Select Remote (LAN/Modem) from the Choose Game screen. This will bring up the 
Choose Connection screen which contains the connection methods available on your 
machine via Microsoft’s DirectPlay™, a family of connection technologies which allows 
you to play over various connection types (DirectPlay is part of DirectX, which is 
provided if your system doesn’t already have it installed).

Connection Methods - If your system has the necessary components for the 
DirectPlay option, it will be displayed on this screen. For example, if your system 
doesn’t have a modem installed, the Modem Connection option will not be displayed.

LAN Connection - Select this to play across a network that supports the 

communications protocol, then start or join games on the Local Area Network. When 
DirectPlay searches for available games on your network, only games that have been 
started by users on your same subnet will be found. These games will be displayed on 
the Available Games screen.

Modem Connection - Enter the phone number of a machine to connect and 

configure the modem you will use.

Available Games Displays the games which are available to join and allows a host to 
start a new game. The available game list will refresh periodically.

Start Game - Type the name of the new game into the edit box in the upper left 

portion of the screen, then click the Create Game button. Other players will see the 
newly created game and will be able to join it.

Join Game - Double click the name of a game to join. If the game has already 

started, then choose to join the game when prompted.
Watch Game - Double click the name of a game that has already started, then 

choose to watch the game when prompted.

Hosting and joining a remote game are similar for all connection methods.

LAN Installation - You can install the game on a server connected to the LAN. This will 
reduce the disk space required on your machine and increase the performance 
compared to running from the CD.

Requirements - Make sure you have at least 650 MB available on the server.

Copy Courses - Copy the contents of the Courses CD to a directory on the 

server.
Installation - Install the game using the Compact installation from the Installation 

CD. When you are prompted to put in the second CD, edit the directory path to point at 
the directory on the server where the contents of the Courses CD have been copied.

Note: If you have a course installed on a LAN, you can use the Course Manager 



to install that course for all machines intending to use it. Use the Course Properties to 
change the location of the course.



Remote Game
Remote games play much like local games, except that you must first establish a 
connection with the other computers involved. PGAC Golf uses the concept of a Game 
Host in order to start a remote game. The Game Host is the player who starts the 
remote game, chooses the game parameters, and waits for the other players to join.

The general outline for setting up a remote game is as follows:
Establish a connection.

The Game Host starts a game.

Other players wishing to compete in the game can then join.

Those who are joining then select which golfer(s) they want to use in the game.

The host then selects the golfers who will actually play in the game, then starts 

the game.

There are two types of remote connections available in PGAC Golf:
Direct Play (LAN/Modem) - Remotely connect with co-workers across a LAN 

(local area network), or with friends using a direct modem connection.
Internet (  World Opponent Network (WON)  )   - This option allows you to play 

with people all over the world via this FREE Internet gaming system.

Hosting a Game - Choose to host the game using one of the connection methods 
provided. The Game Settings screen will be displayed followed by the Who's Playing 
screen. After selecting the game settings, the game is started and other players may 
begin to join. The host may then monitor the players joining on the Who's Playing 
screen and start the game whenever desired. Players who have not been selected to 
play will be removed from the game. Leaving a game at certain times can make it 
impossible for the game to continue. For example, if you quit while waiting for other 
players to join the game, the remote game will end and any players who have joined up 
to that point will be removed. On the other hand, if you leave a game that you are 
hosting after all players have joined and the game has started, most types of play will 
allow the remaining players to continue without you. You will always be informed if 
leaving a game will cause the game to end.

Joining a Game - Choose to join a game using one of the connection methods 
provided. Once you have joined a game, you will be taken to the Game Settings screen. 
You will not be allowed to change the settings and will not be allowed to continue from 
this screen if you do not have the course being played. If you have the course and 
joined the game when prompted, you will then be able to select player(s) from the 
Who's Playing screen, however, if a game is using handicaps, you will only be allowed 
to select player(s) who have established handicaps. The host will not see the player(s) 
you have selected until you are finished with the Who's Playing screen. At that point, the 
host may elect to remove some or all of your players from the list. The game will begin 



when the host is finished with the Who's Playing screen. If all of your players have been 
removed, you may join the game in progress but you will not be playing with the initial 
group.

Watching a Game- Choose to join a game using one of the connection methods 
provided. Once you have joined a game, you will be taken to the Game Settings screen. 
You will not be allowed to change the settings and will not be allowed to continue from 
this screen if you do not have the course being played. If you joined the game after it 
was started, then you will be asked if you want to watch or join the game already in 
progress. Choose to watch the game.

In the Game - On-screen messages allow players to communicate with each other 
during game play. Players can send text, motions, and sounds to everyone, or specific 
players. This is perfect for those moments when you simply must comment on your 
opponent’s most recent slice into the bushes, and to give the thumbs up to your team 
mates.

Rejoining A Game - If you are disconnected from your current game, you may rejoin 
that same game as long as there is at least one player still in the game. However, if you 
voluntarily shut down the game by clicking on Exit, then you will not be allowed to 
rejoin.
To rejoin a game:

If PGAC Golf was terminated, you must restart it. You will then be asked if you 

wish to resume your previous game. Selecting 'Yes' will lead you through the process of 
rejoining. Selecting 'No' will not permit you to rejoin.

If your remote connection was disconnected, reconnect without exiting PGAC 

Golf. Find the game you were playing and double click on it.

Note: To avoid long waits between turns, players should be placed in groups no 

larger than four. For example, if eight friends organized a remote game, the players 
should be organized into two groups of four or four groups of two. The scores for all 
players in the remote game are posted on the Leaderboard and players can be viewed 
by creating a custom camera to follow that player.



Remote Message
PGAC Golf provides on-screen messages for remote games, which allows you to 
communicate with other players in the game without cluttering up your screen with a 
message window.

To send a message, press either [F5], [F6], [F7], [F8], [F9], [F10], or [F11], type your 
message in the space provided, select a motion and sound you want your golfer to 
perform, then click Send. Each of these function keys saves the last message so you 
can easily resend the same message later. You can choose an individual player to send 
to, or broadcast your message to everyone in the game. If multiple players are playing 
from the same computer, you can select which of the players will respond. The 
message you send will appear on your screen and the screen of every player who 
receives the message.

You can preselect messages for your function keys by pressing Save instead of Send. 
The next time you open the message, it will default to the last saved message. For 
example, you could setup F8 to broadcast an excited sound and motion, then always 
use F8 when responding to excellent shots.

You may send a “Hurry up” message to all players by pressing [F12] on your keyboard. 
This sends the message “Hurry up” to all players in the game and plays one of the 
heckler comments.

All of the function key messages are available through the Remote Menu in the Menu 
Options. It has entries for all four regular message keys [F5-F11], Hurry Up [F12], and 
Clear Messages (Delete).



Remove Detail
Removing detail is a performance increasing feature that no designer should ignore. 
When doing elevation operations, (Hill, Bunker, Slope, Smooth & Flatten) detail is added 
to the course to make the elevations look good. The architect will add detail only to the 
area affected by the elevation change. As more detail is added from multiple elevation 
operations, redundant points begin to appear in the course. This redundancy should be 
removed.

Redundant detail is eliminated using the Remove Detail tool. Moving the cursor over a 
Land Shape that outlines the area in question. The point density panel on the right end 
of the Status Bar will show the density percentage of that shape. Click the right mouse 
button and choose Remove Detail from the menu that appears. When the dialog 
appears, select the level of removal that is desired. If detail needs to be removed from 
the objects enclosed within the shape, select the include children option.

It is very important to run this tool periodically during the creation of courses. Removing 
detail will improve the performance of the architect by reducing the size of the course 
file and memory used. All terrain objects should have detail removed at the smallest 
detail removal setting (even greens and bunkers). This removes significant detail 
without affecting the visual appearance of the course. Many terrain objects should have 
detail removed at much higher levels. Examples of these objects are the main weed-
rough texture that encircles the whole course, as well as objects that house flower beds 
or forests.

Note: Use the Point Density Indicator in the Tools Menu to quickly find shapes 

that have a high percentage of detail points. These shapes often have redundant or 
unnecessary points that can be removed.



Resume (Game/Shot)
Game files are saved as .GLF files and are located in the PGAC Golf \ Save directory. 
You can double click a .GLF file directly in Explorer to launch PGAC Golf and start the 
saved game. These files can also be opened by selecting Resume from the Main Menu 
screen. A window will appear with a list of available games. Select the game to be 
resumed. Then press Resume to start the saved game.

To save a game, select save from the Game Menu. To save a shot, save the game after 
the player has taken a shot, but before Continue is pressed on the Button Bar or Action 
Menu.

Note: If a player has been deleted, they will remain in saved games and will still 

be used by resuming the game. You may not resume games or shots that were saved 
on a course that you do not have.



Scores
The scores can be viewed using the View Menu (Hot Key: Alt + V, then press S). The 
screen defaults to a Score Card. It will contain the scores for each player in the player's 
group. It can be switched to a leaderboard which will display the scores for every player 
in the tournament.

The score screen will show the current course conditions and the course difficulty in the 
upper left corner. The conditions were selected from the Game Settings screen and the 
course difficulty is used in calculating handicaps.

The score screen contains many buttons that will sort the list. Sort the list using the 
Name, Team, Score, Handicap, strokes on a hole, and total strokes. Just click on the 
button and the list will update. The handicap column displays the teams handicap that is 
being used in calculating the score. It will only be displayed if you select Use 
Handicaps from the Game Settings screen.

Click the Back 9/Front 9 button to see the back nine and front nine scores.

Click the Leaderboard/Score Card button to view every player's score or just 

the scores in your group.

If you are playing 72 holes, there will be four buttons at the bottom of the screen that 
specify which round is being played. Select the round you want to view and the list will 
update.

Note: You can print the current scores by pressing the print button 

 in the top right corner of the scores screen. This will print all scores for each player in 

the order they are currently listed.



Shot Setup
Shot Setup offers an interface that will allow you ultimate control over the golfer's swing. 
You can adjust the club face to open or closed, move the ball forward or backward in the 
stance, and change the swing plane to outside-in or inside-out. Shot Setup will then 
allow you to save your custom shot types. These features, combined with the 
TrueSwing™ method, allow the swing to be customized for just about any shot.

Click on the  shot setup icon in the lower left section of the Swing Camera or 
use the Action Menu item Shot Setup (Hot Key = Shift + S). The golfer will rotate up 
for better visibility and the Button Bar will show the setup shot buttons. When you find a 
satisfactory stance, click Done or press ESC to return to the game.

The button bar on the right contains some pre-defined stances and two custom stances. 
All pre-defined stances can be changed by pressing Save after editing it. Choose 
between the following stances:

Straight (Hot Key = Shift + I) - Reset the shot variables to hit the ball straight.

Draw (Hot Key = Shift + D) - Setup a draw shot to get the ball to curve slightly to 

the left. This can be used on fairways that curve slightly to the left.
Fade (Hot Key = Shift + F) - Setup a fade shot to get the ball to curve slightly to 

the right. This can be used on fairways that curve slightly to the right.
Punch (Hot Key = Shift + P) - Setup a punch shot to keep the ball very low and 

make it travel as far as possible. This is useful for keeping the ball under trees.
Flop (Hot Key = Shift + O) - Setup a flop shot to keep the ball very low and 

make it travel a short distance. This can be used to get back on the fairway from within 
the trees.

Custom (Hot Key = Shift + 1 or 2) - Select one of the Custom buttons, then 

customize the shot. Press Save in order to change the Custom shot. Then next time you 
wish to setup the same shot, just press the    same Custom button and the last values 
will be returned.
The button bar on the left allow you to save, restore, or apply the current settings. 
Choose between these options:

Save - Save the current settings into the pre-defined stance button. The next 

time you select the button, these settings will be used.
Restore - Restores the pre-defined stance button to it's default value. For 

example, if you customize the draw shot and want to restore it to the default, then select 
Draw, press Restore, and finally select Save.

Done (Hot Key = Esc)- This will end the Shot Setup mode and apply the 

currently selected shot to the players stance. The selected shot will remain active until 
the player continues to the next position. The player will then default to a straight shot.

You can create your own shots using by moving the golfer, club and ball.



Opening/Closing the Club Face - Move the cursor over the club face until the 

cursor changes to a rotation arrow. Click the left mouse button and drag the club face 
open or closed.

Opened - When the club face is opened, the ball will be hit to the right and will 

gain extra loft. Opening the club face is typically used to pop the ball over bunker lips or 
bushes.

Closed - When the club face is closed, the ball will be hit to the left and will lose 

some loft. Closing the club face is typically used to keep the ball low in order to stay 
under trees.

Moving the Ball - Move the cursor over the ball until the cursor changes to a 

hand. Click the left mouse button and drag the ball forward or backward.
Forward - When the ball is forward in your stance, you will tend to strike the ball 

while in the upward motion of your swing. Moving the ball forward is a subtle means of 
gaining extra loft in the ball.

Backward - When the ball is backward in your stance, you will tend to strike the 

ball while still in the downward motion of your swing. Moving the ball backward is a 
subtle means of reducing the loft of the ball.

Rotating the Swing Plane - Move the cursor over the golfer until the cursor 

changes to a rotation arrow. Click the left mouse button down and drag the golfers 
swing plane inside-out or outside-in.

Inside-Out - When the swing plane is inside-out, (pointing right of forward) the 

ball will draw or hook. This can be useful for fairways that curve to the left.
Outside-In - When the swing plane is outside-in, (pointing left of forward) the ball 

will fade or slice. This can be useful for fairways that curve to the right.

Note: The shot setup interface is not available while putting.



Sound Options
All of the game options discussed in this section are available from the opening Main 
Menu screen by clicking Options or during the game by selecting Options (Ctrl + O) 
from the Game Menu. This opens a screen with four sections: General, Sound, Course, 
and Golfer. Click Sound. Some sounds are specific to Tournaments and other to 
Recreation.

All Sound - Master switch to turn all sounds on or off. Turning sounds off on 

machines with the minimum requirements for memory results in more resources being 
available for the game play

Sound Events - Choose the frequency of each sound event or turn them off 

completely. This allows you to decrease sound you find annoying or increase the 
sounds you love to hear. These options are available on Options from the Game 
Settings screen. Select the frequency from the drop down list, or click the 

 check boxes to affect these sounds:

Ambient Sounds - Sprinklers, birds, and planes.

Player Comments - First and second person comments and remarks if 

Recreation is selected.
Heckle Comments - Snide remarks from a high strung heckler when you delay 

too long and Recreation is selected.
Music - Turn the games music on or off.

T.V. Announcers - Play by play commentary by T.V. announcers if Tournament is 

selected.
Crowd Sounds - Cheers, sighs, and the ever famous golf clap if Tournament is 

selected.
Collision Sounds - Ball impact with trees and terrain.

Swing Sounds - Swing and impact sounds.

User Initiated - Comments initiated by a remote player on another machine.

Recommended Settings - Resets all options to the settings recommended for the 

current machine speed and ram requirements.



Statistics
There are four sets of statistics which the game can automatically track: Player, Course, 
Top Medals, and handicaps. These statistics are useful in comparing players and 
courses. The statistics can be viewed by selecting Stats from the Main Menu or by 
selecting Stats (Shift + S) from the View Menu.

When playing Internet games, some rooms will calculate statistics that will be displayed 
online.

In order for statistics to be calculated, you must be playing regulation rules. Regulation 
can be selected from the Game Settings screen under Options. You will not be able to 
take mulligans or gimmies using regulation rules since both would alter the statistics.

The player statistics include the following:
Holes Played Number of holes played.

Rounds Finished Number of rounds finished.
Holes In One Number of holes-in-one achieved.

Chip Ins Number of chip-ins achieved.
Driving Distance Average distance achieved per drive.
Driving Accuracy Percent of the drives that landed on the fairway.

Average Putts Average number of putts to get to the cup.
Sand Saves Percent of par recovery from landing in sand.
Scrambling Percent of par recovery without green in regulation.

Greens in Reg. Percent of greens hit in regulation (green hit in par -2)
Handicap The player’s handicap.

Average Score Average score per round.
Total Eagles Number of eagles achieved.

Birdies Per Round Percent of birdies per round.
Pars Per Round Percent of pars per round.

Bogeys Per Round Percent of bogeys per round.
Other Percent of remainder.

Average Par 3 Average strokes on par threes.
Average Par 4 Average strokes on par fours.
Average Par 5 Average strokes on par fives.

*Deleting and recreating a player will remove it's statistics.

The course statistics include a column for the front 9, back 9, and for the entire 18 
holes. The statistics include the following:

Total Yards Total number of yards for the course.
Total Par Par for the entire course.

Holes In One Number of holes in one achieved on the course.
Driving Accuracy Percent drives that landed on the fairway.

Average Putts Average number of putts to get to the cup.
Greens in Reg. Percent of greens hit in regulation (hitting the green in par 

-2)
Average Score Average score per round.

Total Eagles Number of eagles on the course.
Birdies Per Round Percent of birdies per round on the course.

Pars Per Round Percent of pars per round on the course.
Bogeys Per Round Percent of bogeys per round on the course.



Other Percent of remainder.
*Use the Course Manager to delete the stats for a specific course.

The top medals screen shows a list of the top scores achieved on the current course 
using Medal play. New players are added to the list at the end of a Medal round. 
Computer players are not added to the list.

Note: You can print the current statistics by pressing the print button 

 in the top right corner of the statistics screen.



Status Bar
The Status Bar is displayed along the bottom of the main application window. It can be 
displayed or removed by selecting Status Bar from the View Menu. There are several 
pieces of useful information displayed in the Status Bar. From left to right, they include:

Button/Menu Item Descriptions - When you move the cursor over a button or 

menu item, this panel shows a description of the tool and what it does.
Current Mode - The current mode of the architect is displayed in this panel. The 

current mode can be Freehand, Measure, Rotate, Select, etc, depending on the tool 
currently being used.

Position & Elevation Feedback - Any position on the course can be described by 

an (x, y) position. As you move the mouse cursor over the course in the Work Window, 
this panel will display the current position and elevation on the course. The units will 
either be in feet/inches or in meters/centimeters, depending on the setting selected from 
the General Options in the game.

Point Density - As you move the mouse cursor over a dropped land shape in the 

Work Window, this panel shows how much of the maximum allowable number of points 
that the object contains. Use Remove Detail to reduce this number where applicable.



Swing (Tri-Click)
The Tri-Click swing has been the traditional interface for swinging the club in PC golf 
games. You will see a Tri-Click indicator directly below the golfer that will be used to 
meter the swing power and lateral spin.

There are four parts to the Tri-Click swing:
Starting the Swing - Move the cursor over the Tri-Click meter or the golfer until 

the cursor changes to a 
 swing arrow.

The Backswing - Click with the left mouse button to start the backswing. The 

meter will begin to move right to indicate the backswing. As the meter continues, the 
swing power is increased. The mark on the right side of the indicator represents full 
power.

The Downswing - Click again with the left mouse button to set the power and 

start the downswing. The meter will begin to move left to indicate the downswing. As the 
meter continues, the lateral accuracy is increased. The mark on the left side of the 
indicator represents a straight shot.

The Impact - Finally, click again to set the accuracy and finish the shot.

There are two variables to the Tri-Click swing:
Swing Power - To hit the ball harder, simply allow the indicator to travel closer to 

the mark on the right (take a bigger backswing) before initiating the down swing. 
However, the more powerful the swing, the more difficult the accuracy becomes.

Lateral Movement - When the club head strikes the ball with any kind of left-to-

right or right-to-left motion, it will impart lateral spin on the ball. The ball’s flight will be 
curved because of the lateral spin. This will happen if you don't hit the mark on the left 
side perfectly.

Draw Shots - (A shot that curves slightly to the left.) To create a draw, click (the third 
click) slightly before the swing indicator reaches the mark on the left side of the swing 
meter.

Hook Shots - (A shot that curves extremely to the left.) To create a hook, click (the third 
click) well before the swing indicator reaches the mark on the left side of the swing 
meter.

Fade Shots - (A shot that curves slightly to the right.) To create a fade, click (the third 
click) slightly after the swing indicator reaches the mark on the left side of the swing 
meter.



Slice Shots - (A shot that curves extremely to the right.) To create a slice, click (the third 
click) well after the swing indicator reaches the mark on the left side of the swing meter.

Putting and chipping methods are slightly different  .  



Swing (TrueSwing™)
Interactive TrueSwing™ is an innovative way for you to get the feeling of truly swinging 
the club. You can control the golfer on the screen without having to watch an indicator. 
This naturally makes the experience more enjoyable. You can also produce actual golf 
swings such as draws and fades (and in extreme cases even hooks and slices) by 
changing the path in which you move your mouse. You can also produce heels, toes, 
shanks and miss hits if your club is not centered on the ball during impact.

There are two types of TrueSwing™ to choose from, the vertical swing and the 
horizontal swing. The following example uses the vertical swing. Pulling the mouse back 
is equivalent to pulling the mouse right, and pushing the mouse forward is equivalent to 
pushing the mouse left when using the horizontal swing.

With Interactive TrueSwing™, you can think of your mouse as a “club.” The “face” of the 
“club” is the side of the mouse with the cord. The club velocity is the speed at which you 
move the mouse. When the “face” of the “club” strikes the ball with any kind of left-to-
right or right-to-left motion, you impart spin on the ball.

Note: A golfer in TrueSwing™ mode will not have the indicator that is seen in Tri-

Click mode.

There are three parts to every TrueSwing™:
Starting the swing - To start swinging, move the cursor over or near the golfer’s 

club. The cursor will change to a 
 swing arrow. Click the left mouse button to start the swing.

The Backswing - Pull the mouse back until the golfer has completed the desired 

amount of backswing. Bigger backswings usually result in longer shots. Use the ESC 
key to cancel the swing.

The Downswing - Push the mouse forward to complete the swing. The 

downswing is the most important part of the swing because it controls the power with 
which the golfer will hit the ball, as well as whether the club is moving right-to-left or left-
to-right when the club head meets the ball.

There are two variables to every TrueSwing™:
Swing Power - To hit the ball harder, simply push the mouse forward more 

quickly. The mouse speed parallels the club head speed.
Lateral Movement - When the club head strikes the ball with any kind of left-to-

right or right-to-left motion, it will impart lateral spin on the ball. The ball’s flight will be 
curved because of the lateral spin. If the club is not centered on the ball during impact, 
then the balls flight can be angled or miss hits can occur.

Toe/Heel Shots - (When the club is not centered on the ball during impact) The club 



starts out centered on the ball. As you begin to swing, your back swing may move left or 
right of the center. If you fail to bring the club back to it's starting position, you will hit the 
ball with the toe or the heel of the club. Hitting the ball with the toe or heel will decrease 
the distance the ball will travel and change the departing angle of the ball left or right. If 
you slide severely right or left, you may miss the ball completely. Some terrain types are 
more prone to miss hits. Toes and heels are more common in rough or sand if the club 
is not centered on the ball.

Draw/Hook Shots - (Shots that curve slightly/extremely to the left.) To create a draw or 
hook shot, pull the mouse back and to the left. Then move the mouse forward and to the 
right to start your downswing. Be careful to finish the swing in the same position as 
started to avoid toes and heels. You can control the amount of draw or hook by 
adjusting the amount of left input during the backswing.

Fade/Slice Shots - (A shot that curves slightly/extremely to the right.) To create a fade 
or slice shot, pull the mouse back and to the right. Then move the mouse forward and to 
the left to start your downswing. Be careful to finish the swing in the same position as 
started to avoid toes and heels. You can control the amount of face or slice by adjusting 
the amount of right input during the backswing.

Experiment with different degrees of left-to-right, right-to-left, right-to-right, and left-to-left 
mouse movement during the swing to see the various results.

Putting and chipping methods are slightly different  .  

Note: If you are consistently slicing or hooking the ball, you may have the mouse 

rotated in your hand even though it may appear to be aligned straight. Many mice have 
funny shapes and it is difficult to tell when it is straight. To determine a straight 
alignment, you can move your cursor along a straight vertical line. As long as the cursor 
stays on a vertical line, the mouse is oriented correctly. If you are consistently toeing or 
heeling the ball when intentionally hooking or slicing, try angling the mouse and 
swinging straight.



Swing Camera
The Swing Camera displays the view from just behind the perspective of the golfer as 
default and provides an interface for playing the game. When the Swing Camera is 
created during the initial setup, the machine speed is considered in sizing the Swing 
Camera. The initial size can be adjusted in the same way a standard window can be 
resized.

Note: When you exit the application, the window size and coordinates are saved 

and restored during the next round if you select Save Configuration from the Window 
Menu.

The game can be controlled through the game interface, most of which resides within 
the Swing Camera. Swinging from this view will depend on    the swing method, 
TrueSwing  ™   or Tri-Click. The left region of the window contains information about the 
player and the right portion contains information about the scene.

Upper Left Region - This area includes the player’s name, the current number of 

strokes, hole number, and par for the hole. During games of 72-holes, the current round 
is also displayed. The number to the right of the name is that players score. Different 
types of play use different scoring methods. When using Medal play, a plus figure shows 
that you are over par, a minus figure shows that you are under par, and an E means you 
are even par. You’ll start every Medal round at even par. (Enjoy it while you can!) 

Upper Right Region - This area includes icons that control the window. Icons for 



editing the view or closing it all together are available here.
Lower Left Region - This area includes buttons that can be expanded to access 

specific modes of the game. The currently available actions can be found in the options 
button, this will bring up the Button Bar. The club can be changed by selecting the club 
button, and the Shot Setup can customize the next shot. The angle of the golfer can be 
changed by moving the green arrow slider or by using the left and right arrow keys.

Lower Right Region - This area shows information about the current shot The 

distance, lie, and wind indicators can be seen here. The larger versions provide more 
information but take up more room on the screen. By clicking on the icons, you can view 
and dismiss the larger versions of these indicators. You can use this information when 
analyzing your shot.

Course Region - This is the main area of the view which shows the fairway, 

greens and golfers.
Left Click on any point to move your golfer to that position. This is useful for 

choosing a different tee position, clearing the path for another players shot, or just 
wandering around the course.

Shift + Left Click on any point to move your golfer and camera to that position.

Right Click on any point to see the distance and terrain type.

Right Click on any golfer to see their name and current score..
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Technical Support

Sierra On-Line offers a 24-hour automated technical support line with recorded answers to 
the most frequently asked technical questions. To access this service, call (425) 644-4343, 
and follow the recorded instructions to find your specific topic and resolve the issue. If this fails 
to solve your problem, you may still write, or fax us with your questions, or contact us via our 
Web site.

Technical Support - United States
Sierra On-Line Phone: (425) 644-4343
Technical Support Fax: (425) 644-7697
P.O. Box 85006
Bellevue, WA 98015-8506

http://www.sierra.com 
support@sierra.com

Monday-Friday 8:00 a.m. - 
4:45 p.m. PST

Havas Interactive offers a 24-hour Automated Technical Support line with recorded 
answers to the most frequently asked technical questions. To access this service, call (0118) 
920-9111, and follow the recorded instructions to find your specific topic and resolve the 
issue. If this fails to solve your problem, you may still write, or fax us with your questions, or 
contact us via our Internet or CompuServe sites.

Technical Support - United Kingdom
Havas Interactive Main: (0118) 920-9111
2 Beacontree Plaza (Monday-Friday, 9:00 a.m. - 5:00 p.m.)
Gillette Way Fax: (0118) 987-5603
Reading, Berkshire
RG2 0BS    United Kingdom

http://www.sierra-online.co.uk

Support Technique - France
Havas Interactive
Parc Tertiaire de Meudon Téléphone : 01-46-01-46-50
Immeuble "Le Newton" (Lundi au Jeudi de 10h à 19h
25 rue Jeanne Braconnier Vendredi de 10h à 18h)
92366 Meudon La Forêt Cedex Fax : 01-46-30-00-65
France

http://www.sierra.fr

Technical Support - Germany



Havas Interactive Phone: (0) 6103-99-40-40
Robert-Bosch-Str. 32 (Montag bis Freitag von 9h - 19Uhr)
D-63303 Dreieich Fax: (0) 6103-99-40-35
Deutschland Mailbox (0) 6103-99-40-35

http://www.sierra.de

Servicio Tecnico - Spain
Havas Interactive Tel: (01) 383-2623
Avenida de Burgos 9 (Lunes a Viernes de 9h30 a 14h y
1º-OF2 de 15h a 18h30)
28036 Madrid Fax: (01) 381-2437
Spain

Modem Support
CompuServe United Kingdom: 

CompuServe France :
CompuServe Germany :

GO UKSIERRA
GO FRSIERRA
GO DESIERRA

Internet USA:
Internet United Kingdom:

Internet France:
Internet Germany:

http://www.sierra.com
http://www.sierra-online.co.uk
http ://www.sierra.fr
http ://www.sierra.de



Tees
There are five different tees (the starting point on any hole) available. Not all courses 
are equipped with five tees; in the case that the tee type does not exist, the player will 
be placed on the tee that most closely approximates the selected tee. The five options 
are:

Forward - For beginning players. These tees are closest to the hole.

Ladies - For standard players. Many golf courses have ladies tees.

Amateur - For standard players. The standard middle tee position.

Pro - For advanced players. Often the same as the tournament tees.

Tournament - For advanced players. These tees are usually the farthest from the 

hole or placed in the most difficult position.

Note: Selecting All golfers play tournament tees from the Game Settings 

screen on Options will force all players to use the Tournament tees regardless of any 
previously selected tee.



Tools Menu
The Tools Menu contains options to create or edit shapes and objects in the Work 
Window. You can measure or rotate existing objects and make elevation changes to the 
course.

          Create Land Shape (Hot Key = L)   - Used to create land shapes for the course. 

Land shapes begin in the    Work Window as objects that float above the course. While 
they are floating, the points can be selected, pulled around, inflated, and rotated. 
Dropping a land shape makes it part of the terrain. Once the shape becomes part of the 
terrain it cannot be resized or repositioned until it is picked up again.

          Create Path (Hot Key = P)   - Used to begin creating a path. It is created by 

clicking the left mouse button on the Work Window. Each mouse click will add a new 
point to the path shape line. The last point is added by double clicking the left mouse 
button. The sides of the path are always parallel to the central line segment.

          Create Hazard Area (Hot Key = H)   - Parts of the course may be marked as 

hazard areas. When the course is played and the ball lands in these areas the hazards 
rules will apply. Hazard shapes are not dropped onto the course. They always float 
above the course and are drawn in red. Create the hazard areas by clicking once for 
each point, and double clicking to finish the shape.

Create Course Perimeter (Hot Key = C) - Mark the outside boundaries of the 

course.
Rotate (Hot Key = Ctrl + R) - Rotate selected objects and points around a central marker. 

After selecting Rotate, a square with a cross in it will appear on the screen. This marks the spot 



around which all selected points and objects will be rotated. Move this mark by clicking it with 
the left mouse button, and dragging it to a new position. Rotate the points by clicking the 
selection with the left mouse button and dragging it around the screen. To finish rotating the 
points, select Rotate again. Interesting changes can be made to a shape by selecting only some of 
the points before beginning the rotate.

Measure (Hot Key = Ctrl + M) - The measuring tool will show the horizontal and vertical 

changes between two points on the course. To start measuring hold down the left mouse button 
on the Work Window and drag the cursor around the course. If the game is set to use the metric 
system, then the Measure tool’s units will be in metric as well. To change this setting, use the 
General Options in the game.

The Land Tools:
Make a hill (Hot Key = Alt + Shift + H) - Press this button to bring up the hill tool. 

This tool can be used to move the land up or down with smooth edges. The transitions 
between modified land and unchanged land is smooth.

Make a bunker (Hot Key = Alt + Shift + B) - Press this button to bring up the 

bunker tool. This tool is used to move land up or down with sharp edges. The transitions 
around the Land Shape's edge will be sharp.

Make a slope (Hot Key = Alt + Shift + L) - Press this button to bring up the slope 

tool. This tool is used to move land up or down with a sloping edge.    The Slope Tool will 
make a hill or depression with a sharp edge. The transitions around the Land Shape's 
edge will be sharp. If the ground is originally flat, this tool will make an elevation change 
where the sides of the change are flat. This tool is especially useful when trying to tilt all 
or part of the entire course.

Smooth an area (Hot Key = Alt + Shift + S) - Press this button to use the 

smoothing tool. Smoothing can get rid of irregularities that creep in from frequent 
elevation changes made to the land by the other tools. This tool will allow you to specify 
anything from lightly to aggressive smoothing. When the tool is instructed to lightly 
smooth, it considers a small radius around it in determining the new elevations. For an 
aggressive smooth, the tool will consider large areas of terrain to find the general trend 
in the terrain. Everything within the selected Land Shape will be smoothed. Smoothing 
is not a real-time operation, after the operation is specified, then the changes are 
applied.

Flatten an area (Hot Key = Alt + Shift + F) - Press this button to use the flatten 

tool. Flatten will make the selected area flat and optionally level. A dialog will offer these 
four options for flattening:

Along Contour - This will flatten the area to match the contour of the selection. 

This is useful if you have a bunker in a side hill and want to remove it. The area will be 
flattened to match the side hill. This tool can produce strange results when used on 
uneven terrain. It is best used on simple elevation changes.

Maximum Height - This will flatten everything in the selection to the maximum 

height inside it.



Average Height - An average height of all the terrain inside the selection is 

calculated and the terrain is set to this height.
Minimum Height - This will flatten everything in the selection to the minimum 

height inside it.
Care should be taken when using this tool, for it will destroy any elevation 
information inside the selection and replace it with the flattened terrain. A single 
floating land shape must be selected to use this tool. Everything within this 
selection will be flattened. This tool will result in very sharp edges and is used 
well in conjunction with the smoothing tool. Flattening is not a real-time operation, 
after the operation is specified, then the changes are applied.
Note: Multiple land operations will begin to add redundant points to the course. 

Removing detail will increase performance without reducing the visual quality.

Foresting Tool (Hot Key = Shift + F) - Use this tool to forest an area or place 

flowers in a flower bed. Before selecting this tool, create and/or select a land shape 
where the objects should be place. Then click on this tool to bring up the Foresting Tool 
dialog. This dialog allows you to choose the object, height, and the number of objects to 
place inside the land shape. Click the Apply button to forest the shape with the selected 
object. This tool can be used many times on the same land shape.

Click-Click Object Tool (Hot Key = Shift + O) - This tool adds an object such as a 

tree or building to the course. Once an object has been selected from the library view, it 
will be placed on the course each time the left mouse button is clicked over the Work 
Window.

Hole definition tool (Hot Key = D) - Define all of the positional information for the 

course (tee positions, pin positions, etc.)
Point Density Indicator (Hot Key = Alt + Ctrl + D) - Each dropped shape has a 

limit to the number of points that are used to define the terrain within that shape. This 
tool allows you to select all dropped land shapes that have more than a certain 
percentage of their maximum density in points. For example, if 50% is selected, this tool 
will highlight all the shapes that have 50% or more of their point limit. This is useful in 
targeting shapes that can be used with the Remove Detail tool.

Grid Settings (Hot Key = Shift + G) - Brings up the Grid Settings screen which 

allows you to select the distance between the grid intersections. When the grid is 
enabled, it will be displayed in the Work Window. Each dot in the grid represents an 
intersection of the grid sections. Select Grid from the View Menu, or use the grid button 

 from the Button Bar to turn the grid on or off.

Note: Do not confuse this grid with the grid that shows up when doing elevation 

changes.
Repair Course - Goes through the entire course and repairs any invalid data. 

Occasionally when dropping land shapes or performing terrain elevation changes, 
redundant or invalid data is introduced. These situations arise very rarely but are difficult 



to detect without running this tool. If a repair was needed, you will be informed. Running 
the tool when no corrections are needed has no effect.



Trouble Shooting
If there is a problem, check these trouble shooting methods for our suggested solution.

Trouble shoot - PGA Championship Golf.

Trouble shoot - Course Architect.

If problems persist, give us a call:
Technical Support

International Support

Direct Sales Information



Trouble Shooting (Architect)
Problem: The architect won't run because it is missing a default texture.
Solution: Make sure you have at least one course library installed on your machine.

Problem: Shapes won’t drop into the terrain.
Solution: The Course Architect requires that only one other shape enclose each land 
shape. The outside land shape is called the parent shape. If you try to drop a land 
shape across the edge of another shape this would cause it to have more than one 
parent and the Architect will not allow that.

Problem: The Course Architect will not run.
Solution: If the Course Architect begins to load and then quits back to Windows it most 
likely that you have not installed the course libraries correctly on your machine. It is also 
possible that a library is installed that does not support the basic rough, fairway, and 
fringe textures. Reinstalling the Course Architect will fix the problem.

Problem: A new architect course has poor performance.
Solution1: Remove the detail in areas that are rarely seen in the course.
Solution2: Decrease the size of the course perimeter.

Problem: The players face the wrong direction when playing an architect course.
Solution1: Make sure the shot path was defined correctly in the hole information.



Trouble Shooting (Game)
Problem: Rendering time is very slow.
Solution 1: Decrease the window size.
Solution 2: Turn off shadows from the Machine Options screen under Course.
Solution 3: Reduce the horizon distance from the Machine Options screen under 
Course.
Solution 4: Increase the permanent course swap size from the Machine Options screen 
under Course.
Solution 5: Reduce the terrain detail, trees and object detail, and panorama detail on 
the Machine Options screen under Course.

Problem: The quality of the scene is poor. 
Solution 1: Increase the terrain detail from the Machine Options screen under Course 
screen.
Solution 2: If the course seems too dark or light, adjust your monitor settings. The 
courses have been colored to favor average monitor settings.

Problem: The golfer looks choppy during swings. 
Solution 1: Reduce the golfer detail from the Machine Options screen under Golfer.
Solution 2: Reduce the size of the golfer by reducing the window size, or by backing 
the camera further away from the golfer.
Solution 3: Close any alternate views.

Problem: The swing cursor does not appear for a shot in the Swing Camera.
Solution 1: Make sure that the Continue button has been selected from the Button Bar.
Solution 2: Make sure the game is active by clicking on the title bar.
Solution 3: Make sure the golfer that is up is a local human.

Problem: The game seems to access the CD a lot during the game.
Solution 1: Increase the permanent course swap size from the Machine Options screen 
under Course screen.
Solution 2: Reinstall the game using a larger install option.

Problem: The game is taking up too much hard drive space.
Solution 1: Reduce the permanent course swap size from the Machine Options screen 
under Course screen.
Solution 2: Reinstall the game and choose a smaller installation size.

Problem: When playing remote games, my connection is frequently terminated.
Solution: The game may be timing out due to a slow connection. Select Tolerate High 
Latency from the Menu Options to allow slow remote connections.

Problem: When I try to launch PGAC Golf, I receive an error message that says, “Error 
Starting Program: A required .DLL file, DPLAYX.DLL, was not found.” (Note: It may also 
have DDRAW.DLL or DSOUND.DLL instead of DPLAYX.DLL.)
Solution: The proper version of DirectX is not installed on your system. DirectX 6 must 



be installed on your computer for PGAC Golf to run correctly. If Setup skipped the 
installation of DirectX and you do not have the latest DirectX installed on your computer, 
you will need to manually install it using Microsoft’s own DirectX Setup program. To 
manually install DirectX, complete the following instructions:

1. With the PGAC Golf CD in the CD drive, double-click My Computer on your 
desktop.
2. Highlight the CD drive (usually D: or E:).
3. From the File Menu, select Open (double-clicking on it will launch AutoPlay).
4. Open the DirectX folder.
5. Find and open/launch the DXSETUP.EXE file (double-click on it). 
6. Select REINSTALL DIRECTX and follow the on-screen prompts.

Problem: The golfer motion skips or stutters when outdoor sounds play.
Solution 1: Reinstall the game and choose a larger install option.
Solution 2: Turn off outdoor sounds.

Problem: I'm having a hard time with TrueSwing™.
Solution 1: Don't hold the mouse button down during the swing.
Solution 2: Don't move your arm so much during the swing.

Problem: My clubs don't seem to hit the distances they suggest.
Solution : These are just average distances, the more a player plays, the closer these 
numbers will become.

Problem: Some players can hit further than mine.
Solution : Check your Player Ability, it will affect how far you can hit the ball.



Types Of Play
PGA Championship Golf offers twelve types of play to choose from. The type of play 
can be selected from Type Of Play on the Game Settings screen. Some types of play 
use teams of two or four. You must select the correct number of players on the Who's 
Playing screen in order to fill the teams. If more than one team exists, you can choose 
which players will be teamed up together on the Create Teams screen after the Who's 
Playing screen.

The rules may seem complicated at first but will become clear after a few rounds.

Medal (One or more players) - This is also known as stroke play. Players 

compete based on their stroke totals at the end of the round or tournament. The player 
with the lowest score (stroke total) wins.

Handicap: Each player uses their full handicap.

Match (Two players only) - Two players compete against each other on each 

hole. The winner of the hole is the player with the fewest strokes for that hole. There is 
no winner if the strokes are equal. The final score is calculated from the number of 
holes won. The player with the highest score wins the round.

Handicap: The difference between the two player’s handicaps goes to the player 
with the higher handicap (the player with the lowest handicap gets no handicap 
strokes). The handicap is applied according to the difficulty or “rank” of the hole (a 
player applies handicap strokes on the most difficult hole first, then the next difficult, 
as would typically happen in match play-based games). The difficulty of the hole is 
shown on the Scores screen in the “HCP” row.

Stableford (One or more players) - Players compete against each other at each 

hole. Points are given for each hole as follows:

Hole Score Points
Two or more strokes over 
par

-3

One stroke over par -1
Par 0
One stroke under par 2
Two strokes under par 5
Three strokes under par 8

The player with the highest final sum wins the round.
Handicap: Each player uses their full handicap.

Four Ball Medal (Two player teams) - This is also known as Best Ball. It is the 

same as Medal except in teams of two. The final score for the team is the sum of the 
lowest scores per hole.



Handicap: Each player uses 90% of their full handicap.

Four Ball Match (Two player teams; Four players only) - Same as Match except 

four players compete in teams of two on each hole. The winner of the hole is the team 
who’s player had the fewest strokes.

Handicap: Each player takes the difference between the lowest player’s handicap 
and their own handicap (the player with the lowest handicap is allowed no handicap 
strokes). For example, player A has a 10 handicap, B has 8, C has 2, and D has 13. 
After adjusting the handicaps for Four Ball Match, A has 8, B has 6, C has 0, and D 
has 11.

Four Ball Stableford (Two player teams) - Same as Stableford except in teams of 

two. The winner of the hole is the team who’s player had the most points.
Handicap: Each player uses 90% of their full handicap.

Skins (Two or more players) - Each player competes against all other players in 

the group on each hole. A screen appears after the Game Settings that prompts for 
dollar amounts to be entered or bet for each hole. There are 18 text boxes (half are 
grayed if playing 9-holes; the same values are repeated for each 18 if playing 72-holes).

There are three buttons on the screen. All Same As First Hole will set all text boxes 
with the same number that you enter in the first one. 1X-2X-3X First Hole Value will 
automatically fill in the remaining text boxes - the first third at the same value as 
number 1, the second third at double the amount, and the last third at triple the 
amount. Randomize First Value will fill the text boxes with random values that are 
similar to the first value.
The skin for a hole is won by the player with the fewest strokes for that hole. If any 
players tie for the low score, all players are considered to be tied and the skin is 
carried over to the next hole. 
For example, using the 1X-2X-3X option, if you are playing an 18-hole round and the 
initial bet is $5 per hole, then the 7th-12th holes are worth $10, and the 13th-18th 
holes are worth $15, assuming no ties carry over into them. If there is a tie on the 
11th hole, then the 12th hole is worth $20. If there is another tie on the 12th hole, 
then the 13th hole is worth $35 (the $20 carryover plus $15 for the 13th hole).
The round is won by the player who has won the greatest dollar amount at the end 
of the round or tournament.
Handicap: Same as Match play.

Scramble (Two player teams) - Players compete in teams of two with both 

players teeing off together. Teams then choose which of the two balls will be played. 
Both team members make the second shot from this point and choose again which one 
to play. The score is calculated from the total number of strokes a team needs to 
complete the round. The team with the lowest score wins.

Handicap: Each team uses 50% of the lowest handicap plus 20% of the highest 
handicap from the two players on the team.



Scramble (Four player teams) - Same as a two-player scramble, but with four 

players per team.
Handicap: Each team uses 25% of the lowest handicap plus 20% of the second 
lowest plus 15% of the third lowest plus 10% of the highest handicap from the four 
players on the team.

Best Ball Ryder Cup (Two player teams; Four players only) - Players compete in 

teams of two with each player alternating drives at each hole. The player that does not 
drive hits the second shot. The players continue to alternate until the ball is in the cup. 
The winner of the hole is the team with the fewest strokes for that hole. There is no 
winner if the strokes are equal. The final score is calculated from the number of holes 
won. The team with the highest score wins the round.

Handicap: The team with the highest number of combined handicap strokes gets 
50% of the difference between the two teams’ strokes and the other team is allowed 
no handicap strokes. For example, team A has a 16 handicap and B has a 10. After 
adjusting the handicap for Best Ball Ryder Cup, A has 3 and B has 0.

Best Ball Greensome (Two player teams; Four players only) - Players compete in 

teams of two with both players teeing off at each hole. They then choose which of the 
two balls will be played. The player whose ball was not chosen hits the second shot and 
the team alternates until the ball is in the cup. The winner of the hole is the team with 
the fewest strokes for that hole. There is no winner if the strokes are equal. The final 
score is calculated from the number of holes won. The team with the highest score wins 
the round.

Handicap: The team with the highest number of combined handicap strokes gets 
40% of the difference between the two teams’ strokes and the other team is allowed 
no handicap strokes. For example, team A has a 19 handicap and B has a 14. After 
adjusting the handicap for Best Ball Greensome, A has 2 and B has 0.

Best Ball Bloodsome (Two player teams; Four players only) - Players compete in 

teams of two with both players teeing off at each hole. The opposing team then chooses 
which of the two balls will be played. The player whose ball was not chosen hits the 
second shot and the team alternates until the ball is in the cup. The winner of the hole is 
the team with the fewest strokes for that hole. There is no winner if the strokes are 
equal. The final score is calculated from the number of holes won. The team with the 
highest score wins the round.

Handicap: Same as Greensome play.
The handicap for the team is then divided into eighteen parts. The greatest parts are 
used on the hardest holes first. The difficulty of the hole is displayed on the Scores 
screen. For example, if a team has a 38 handicap, then it will be split into two 3’s 
and sixteen 2’s. The two 3’s will be used on the most difficult holes.

Note: In all types of play, ties are handled by Sudden Death if it is selected from 



the Game Settings screen. Golfers play as many additional holes as necessary until one 
player or team emerges victorious.



View Menu (Architect)
The Menu Options contains options to show or hide the button bars and other windows. 
You can use Zoom and Scroll to adjust the Work Window. The arrows correspond to the 
direction the camera will move in the course. They do not change the camera height.

File/Edit tools - Show and hide the file and edit tools.

Course tools - Show and hide the course tools.

Window tools - Show and hide the window tools.

Navigation tools - Show and hide the navigation tools.

Status Bar - Show and hide the status bar.

Course Perimeter (Hot Key = Shift + C) - Show and hide the course perimeter.

Hazards (Hot Key = Shift + H) - Show and hide all hazard shapes.

Shot Paths (Hot Key = Shift + D) - Show and hide all shot paths.

Sound Positions (Hot Key = Shift + S) - Show and hide all positioned sounds.

Grid (Hot Key = G) - Show or hide the grid in the Work Window.

Library (Hot Key = Shift + L) - Show and hide the library window.

Modeling Clay (Hot Key = Shift + M) - Renders the entire course in solid 

modeling clay color.



Zoom - This option will bring up another menu that will allow you to zoom in and 

out of the Work Window.
In (Hot Key = Z) - Move in closer to the course.

Out (Hot Key = Shift + Z) - Move away from the course.

Select (Hot Key = Alt + Z) - Move in until the current selection fills the screen. 

After selecting the button, move the cursor over the Work Window to the top left corner 
of the area. Hold down the left mouse button and drag the cursor to the lower right 
corner of the area, then release the mouse button.

Cancel (Hot Key = Alt + Shift + Z) - Return to the default camera height. When 

zoomed in close to the ground, many times it is easier to cancel the zoom, then use the 
Zoom To Selection tool.

Scroll - This option will bring up another menu that will allow you to move the 

Work Window around the course.
Left (Hot Key = Left Arrow) - Moves the camera to the left. 

Right (Hot Key = Right Arrow) -Moves the camera to the right.

Up (Hot Key = Up Arrow) - Moves the camera toward the top of the screen.

Down (Hot Key = Down Arrow) - Moves the camera toward the bottom of the screen.

Center Camera (Hot Key = Ctrl + C) - Moves the Camera Window into to center 

of the current Work Window.
Center Rotate Origin (Hot Key = Ctrl + Shift + C) - Moves the rotation origin used 

for rotating land shapes into to center of the current Work Window.
Use Metric - The architect will use the metric system in displaying distances.



View Menu (Game)
Choose View from the Menu Options. The View Menu allows you to open alternate 
windows, view the statistics, or the current scores.

Green (Hot Key: Alt + V, then press G) - Shows a bird’s eye view of the green 

looking down.
Approach View (Hot Key: Alt + V, then press A) - Shows a bird’s eye view from 

the fairway looking toward the green.
Driving View (Hot Key: Alt + V, then press D) - Shows a bird’s eye view from 

behind the tee box looking down the fairway.
Reverse Driving View (Hot Key: Alt + V, then press R) - Shows a bird’s eye view 

from the middle of the fairway facing the tees.
Top View (Hot Key: Alt + V, then press T) - Shows a top view of the current hole.

Note: Right-clicking in the top view provides a handy distance indicator to the 

golfer and to the pin. Also, the location will be indicated on the main game screen by a 
marker.

Custom Camera - Open the Camera Editor screen to create a custom camera.

Scores (Hot Key: Alt + V, then press S) - Contains the current scores for each 

player on each hole. The players can be sorted by hole or by total score.
Stats (Hot key = Shift + S) - Opens the statistics screen to view player and 

course statistics.

You can have as many views open as you like, however, the more that are open, the 
slower the speed of play because each one needs to redraw after each hole. You can 
also right-click over any view window to see the terrain type and distance to that point. A 
small marker will show up in the top view over the point that was clicked. During a 
swing, the ball can be seen in each view as it sails through the air or rolls on the green.



Who's Playing
The Who’s Playing screen is where some of the greatest names ever to play PGAC Golf 
are born. It’s also where they get left in the clubhouse! Create, edit, and delete players, 
then select them to join the round.

Create, edit and delete players before you select them to play. There are four buttons 
that allow you to manipulate the players.

Create Player - Create a new player using the Player Creation screens. The 

option is available on the lower left portion of the screen.
Create List - Create a new list of computer players using the List Creation 

screen. The option is available on the lower left portion of the screen.
Edit - Edit the current highlighted player or list. This button is only shown when a 

player or list has been highlighted.
Delete - Asks for a verification, then deletes the highlighted player or list and all 

of their statistics. Saved games will still contain the player, but they will no longer be 
available for a new round. This button is only shown when a player or list has been 
highlighted.

There are two list boxes in the screen, one for the Available Players and one for the 
Selected Players.

Available Players - This box contains a list of players that have been created but 

have not been selected to play in the next round. When a new player is created, an 
entry for that player is added to this list. The entry consists of the player name, followed 
by the handicap. The handicap will be followed by C for computer players, H for human 
players, L for lists of players, and R for remote players.

Selected Players - This list box contains the selected players that will be playing 

in the next round of golf. The Add/Remove button affects who is displayed in this list. 
When a player is added to this list, they are no longer displayed in the Available Players 
list. The entry consists of the player name, followed by the handicap. The handicap will 



be followed by C for computer players, H for human players, L for lists of players, and R 
for remote players.

There are two methods for moving players between the Available and Selected Players 
lists.

 Double-Click - Double-Click directly on the name and it will change lists.

Add/Remove Button - Click once to highlight the name, then use the 

Add/Remove button. The button is available in the center of the dialog only when a 
player's name is highlighted. The name of the button will change depending on whether 
the selected player can be removed or added.

Back to the Game Settings screen.

Cancel to the Main Menu screen.

Play Golf to start the round.

Note: This is the last setup screen before the game starts. You cannot get to the 

Who’s Playing screen with a Quick Start game.



Window Menu (Architect)
The course architect allows three different ways to view the course. The Work Window 
is always visible and is used to place and manipulate shapes and objects. It can be 
maximized to fill the entire application window. All other views can be shown and hidden 
from this menu in the Menu Options.

Work Window - Where all the work is done. It cannot be hidden and may be 

maximized to fill the entire application window.
Float - If the Work Window is currently maximized, this will cause the window to 

float in the application frame like the other windows.
Maximize - This will cause the Work Window to fill the entire application window.

Camera Window - Brings up a perspective view of the course and places a 

 camera icon in the Work Window. You can position and rotate the camera using this 

icon. This window will give you an idea of how the course will look in the game.
Navigation Window - Used to quickly move the contents of the Work Window to 

see different parts of the course. Most of the course can be seen in the Work Window's 
default position, but when the camera is close to the ground, only a small part of the 
course can be seen. The navigation view has a white rectangle that shows how much of 



the course is in view on the Work Window. The rectangle can be moved around by 
clicking the left mouse button inside the rectangle, then dragging it to a new location. 
The Navigation Window can also be opened from the Button Bar.

Cascade - Arranges the open windows in a cascading fashion, starting at the 

upper left.
Tile - Arranges the open windows in a tiled fashion.



Window Menu (Game)
Choose Window from the Menu Options. The items in the Window Menu can be 
checked or unchecked. Their state is saved and resumed each time the game is run.

Views On Top (Hot Key = Alt + W, then press V) - This will place all open views 

on top of the Swing Camera.
Save Configuration (Hot Key = Alt + W, then press S) - This saves the current 

open status, placement, and size of all windows. This configuration will be restored the 
next time the game is run.

Show Tool Tips (Hot Key = Alt + W, then press T) - Turn on tool tips. Simply place 

the cursor over an icon to see the tool tip message. Club distances will be displayed 
when hovering over the clubs in the bag.

Full Screen (Hot Key = Alt + W, then press F) - This hides the Menu Options at 

the top of the screen. To access the Menu Options again, move the cursor to the top of 
the screen and the Swing Camera will automatically shift down to show them.

Hide Button Bar (Hot Key = Alt + W, then press H) - This will hide the Button Bar 

when it is not in use which will increase the view of the course through the Swing 
Camera. To access the Button Bar, move the cursor to the lower left corner of the Swing 
Camera and click on the Options icon.



Work Window
The Work Window is a top view of the course and is visible at all times. The window is 
always visible and can be maximized to fill the entire application window. The Work 
Window is always a top view of the course but its contents can be scrolled around and 
made to appear larger and smaller using the Navigation Button Bar. All course creation 
work is done here including object positioning, land shape selection, and elevation 
changes.

The Work Window can be put into several land shape modes. Each mode corresponds 
to a creation option which allow shapes, points and objects to be selected and 
repositioned. The Work Window can only be in one of these modes at any given time so 
selecting a mode, deselects the current mode.

There is a Status Bar at the bottom of the application window. The status bar displays 
some useful information such as the current mode, position, and elevation of the course 
at the cursor position.




